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1:Introduction

The Third-Party Technical Guidelines is a one-stop-shop document for information about third-
party software application compatibility with NICE systems.

This document should be used by NICE customers and customer service organizations in order to
verify the compatibility of third-party software to NICE products in addition to specific
configuration information.

This document serves as general guidelines and applies to all existing NICE Engage Platform
versions.

Updates for specific product versions may be issued separately based on these guidelines. NICE,
at its sole discretion, may decide to change the general guidelines or deviate from them for a
specific product version.

This document should apply in cases where it contradicts a previous Technical Note.

Contents

Scope of this Guide 10
Document Revision History 11
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Scope of this Guide

Software Version
This guide is updated for:

NICE Engage Platform 6.15

Advanced Process Automation

What is included in this guide?
Guidelines for third party software with NICE applications.

What is not included in this guide?

Topic Where to Find this Topic...

NICE Screen Agent software ScreenAgent Installation and Configuration Guide

Microsoft .NET framework Certified Servers Guide

Setting up a client computer to work
with ASPX

Workstation Setup Guide

Configuring XBAP Workstation Setup Guide

Microsoft Daylight Savings Time
configurations

Maintenance Guide
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2:Microsoft Software Service Packs Certified
by NICE
This section lists the Microsoft Software Service Packs certified by NICE. These service pack
versions are part of the site readiness tests in the SRT, in addition to the minimum hardware and
software requirements that are in the Certified Servers Guide.

Product NICE Engage Platform

Release NICE Engage Platform 6.x

Synopsis Provides information regarding the latest Microsoft Software
Service Packs certified by NICE.

Below are two tables that list the latest Microsoft Software Service Packs certified by NICE for
servers and client machines.

Windows Server and SQL Server Service Packs

Microsoft Software Service Pack NICE Release Comment

Windows 2012

Datacenter 64-bit

NICE Engage Platform 6.x

Windows 2012

Standard 64-bit

NICE Engage Platform 6.x

Windows 2012 R2

Datacenter 64-bit

NICE Engage Platform 6.x
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Microsoft Software Service Pack NICE Release Comment

Windows 2012 R2

Standard 64-bit

NICE Engage Platform 6.x

Windows 2016

Datacenter 64-bit

NICE Engage Platform 6.x

Windows 2016
Standard

64-bit

NICE Engage Platform 6.x

Windows 2016

Datacenter 64-bit

Supported

Creator
Updates:

Version 1709

NICE Engage Platform 6.x

Windows 2016

Standard 64-bit

Supported

Creator
Updates:

Version 1709

NICE Engage Platform 6.x

SQL Server 2012

Enterprise Edition 64-bit

SP1 NICE Engage Platform 6.x

NICE Sentinel 6.x

SQL Server 2012

Standard 64-bit

SP1 NICE Engage Platform 6.x

NICE Sentinel 6.x

SQL Server 2012
Enterprise Edition 64-bit

SP2 NICE Engage Platform 6.x

NICE Sentinel 6.x

SQL Server 2012

Standard 64-bit

SP2 NICE Engage Platform 6.x

NICE Sentinel 6.x

SQL Server 2012

Standard 64-bit

SP3 NICE Engage Platform 6.x

NICE Sentinel 6.x
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Microsoft Software Service Pack NICE Release Comment

SQL Server 2012

Enterprise Edition 64-bit

SP3 NICE Engage Platform 6.x

NICE Sentinel 6.x

SQL Server 2012

Enterprise Edition 64-bit

SP3 CU10 (KB
4025925)

NICE Engage Platform 6.x

NICE Sentinel 6.x

CU Release Date:
August 08, 2017

NICE Certification
Date: March 13,
2020

SQL Server 2012

Standard 64-bit

SP4 NICE Engage Platform 6.x

NICE Sentinel 6.x

SQL Server 2012

Enterprise Edition 64-bit

SP4 NICE Engage Platform 6.x

NICE Sentinel 6.x

SQL Server 2012

Enterprise Edition 64-bit

SP4 (KB
4018073)

NICE Engage Platform 6.x

NICE Sentinel 6.x

CU Release Date:
October 05, 2017

NICE Certification
Date: March 13,
2020

SQL Server 2014

Enterprise Edition 64-bit

NICE Engage Platform 6.x

SQL Server 2014

Standard 64-bit

NICE Engage Platform 6.x

SQL Server 2014

Enterprise Edition 64-bit

SP1 NICE Engage Platform 6.x

NICE Sentinel 6.x

SQL Server 2014

Standard 64-bit

SP1 NICE Engage Platform 6.x

NICE Sentinel 6.x

2: Microsoft Software Service Packs Certified by NICE
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Microsoft Software Service Pack NICE Release Comment

SQL Server 2014

Enterprise Edition 64-bit

SP2 NICE Engage Platform 6.x

NICE Sentinel 6.x

SQL Server 2014

Standard 64-bit

SP2 NICE Engage Platform 6.x

NICE Sentinel 6.x

SQL Server 2014

Enterprise Edition 64-bit

SP3 NICE Engage Platform 6.x

NICE Sentinel 6.x

SQL Server 2014

Standard 64-bit

SP3 NICE Engage Platform 6.x

NICE Sentinel 6.x

SQL Server 2014

Enterprise Edition 64-bit

SP3 CU4 (KB
4500181)

NICE Engage Platform 6.x

NICE Sentinel 6.x

CU Release Date:
July 29, 2019

NICE Certification
Date: February
14, 2020

SQL Server 2016

Enterprise Edition 64-bit

SP2 NICE Engage Platform 6.x

NICE Sentinel 6.x

Playback Portal 6.8

SQL Server 2016

Standard 64-bit

SP2 NICE Engage Platform 6.x

NICE Sentinel 6.x

Playback Portal 6.8

SQL Server 2016

Enterprise Edition 64-bit

SP2 CU11 NICE Engage Platform 6.x

NICE Sentinel 6.x

Playback Portal 6.8
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Microsoft Software Service Pack NICE Release Comment

SQL Server 2016

Standard 64-bit

SP2 CU11 NICE Engage Platform 6.x

NICE Sentinel 6.x

Playback Portal 6.8

SQL Server 2016

Enterprise Edition 64-bit

SP2 CU11 (KB
4527378)

NICE Engage Platform 6.x

NICE Sentinel 6.x

Playback Portal 6.8

CU Release Date:
September 12,
2019

NICE Certification
Date: January 20,
2020

SQL Server 2016

Enterprise Edition 64-bit

SP2 CU12 (KB
4536648)

NICE Engage Platform 6.x

NICE Sentinel 6.x

Playback Portal 6.8

CU Release Date:
February 25, 2020

NICE Certification
Date: March 17,
2020

SQL Server 2016

Enterprise Edition 64-bit

SP2 CU13 (KB
4549825)

NICE Engage Platform 6.x

NICE Sentinel 6.x

Playback Portal 6.8

CU Release Date:
May 28, 2020

NICE Certification
Date: August 7,
2020

SQL Server 2016

Enterprise Edition 64-bit

SP2 CU14
(KB4564903)

NICE Engage Platform 6.x

NICE Sentinel 6.x

Playback Portal 6.8

CU Release Date:
August 6, 2020

NICE Certification
Date: August 28,
2020

SQL Server 2016

Enterprise Edition 64-bit

SP2 CU15
(KB4577775)

NICE Engage Platform 6.x

NICE Sentinel 6.x

Playback Portal 6.8

CU Release Date:
September 28,
2020

NICE Certification
Date: October 8,
2020
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Microsoft Software Service Pack NICE Release Comment

SQL Server 2016

Enterprise Edition 64-bit

SP2 CU16
(KB5000645)

NICE Engage Platform 6.x

NICE Sentinel 6.x

CU Release Date:

February 11, 2021

NICE Certification

Date: March 29,
2021

SQL Server 2016

Enterprise Edition 64-bit

SP2 CU17
(KB5001092)

NICE Engage Platform 6.x

NICE Sentinel 6.x

CU Release Date:

March 29, 2021

NICE Certification

Date: April 23,
2021

SQL Server 2016

Enterprise Edition 64-bit

SP3
(KB5003279)

NICE Engage Platform 6.x

NICE Sentinel 6.x

SP Release Date:

September 15,
2021

NICE Certification

Date: January 22,
2022

SQL Server 2016

Standard 64-bit

SP3
(KB5003279)

NICE Engage Platform 6.x

NICE Sentinel 6.x

SP Release Date:

September 15,
2021

NICE Certification

Date: January 22,
2022

Windows Client Software Service Packs

Microsoft Software SP/Creator Update NICE Release Comment

Windows 10 NICE Engage Platform 6.x
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Microsoft Software SP/Creator Update NICE Release Comment

Windows 10 Supported Creator Updates:

Version 1511

Version 1703

Version 1709

Version 1803

Version 1809

Version 1903

Version 1909

Version 2004

Version 20H2

Version 21H1

Version 21H2

NICE Engage Platform 6.x

Windows 11 Supported Creator Updates:

Version 21H2

NICE Engage Platform 6.x
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Configuration Guide - Cross-Release
Third Party Technical Guidelines (H1) - 23 -



[This page intentionally left blank]



3:Microsoft Server Operating Systems

This section provides information regarding Microsoft Server Operating Systems. This includes
secure solutions, updates, and guidelines.

The list of the certified Microsoft Server Operating Systems versions is in the Certified Servers
Guide. For the detailed information on the specific version, see the Microsoft Windows Server
Configuration Guide.
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4:Microsoft Client Operating Systems

This section provides information regarding Microsoft Client Operating Systems. This includes
secure solutions, updates, and guidelines.

In addition to the operating systems that are highlighted in this section, NICE Engage Platform was
also certified for Windows 7, 8/8.1, and 10.

Contents

General 28
Windows 7 32-bit/64-bit 29
Windows 8 and Windows 8.1 32-bit/64-bit 35
Windows 10 32-bit/64-bit 39
Windows 11 64-bit 43
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General
Localization

NICE does not support machine names and/or domain names with non-ASCII characters (IRI) on
Client workstations.
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Windows 7 32-bit/64-bit
Client Application Compatibility
NICE Systems supports the following editions of Microsoft Windows 7 in both 32-bit and 64-bit
configurations:

Microsoft Windows 7 Professional Edition

Microsoft Windows 7 Enterprise Edition

Microsoft Windows 7 Ultimate Edition

The following table shows the compatibility of NICE Engage Platform client applications with
Microsoft Windows 7:

Important!

NICE Applications and the Set Security feature support only the 32-bit version
of Internet Explorer.

(*) These components must be installed with the UAC turned OFF.

Application NICE Engage 6.x

Windows 7
32-bit

Windows 7
64-bit

Screen Agent Approved Approved

ROD Client Approved Approved

Standalone NICE Player and
NICE Player Codec Pack

Approved Approved

Reporter Viewer Approved Approved

NICE Applications (including Set
Security)

Approved Approved

Survey Manager Approved Approved

Table 4-1: Compatibility With Microsoft Windows 7 32-bit and 64-bit by Release

4: Microsoft Client Operating Systems
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Application NICE Engage 6.x

Windows 7
32-bit

Windows 7
64-bit

VRA Approved Approved

Media Library Approved Approved

BSF Tool kit Approved Approved

NICE Sentinel Remote Client Approved Approved

Desktop Analytics (using PO
Client)

Approved NICE Approval

RTS Approved Approved

Table 4-1: Compatibility With Microsoft Windows 7 32-bit and 64-bit by Release (continued)

Using Silent Installation to Install Client
Applications

NOTE: The commands listed below are applicable to both Microsoft Windows 7
32-bit and 64-bit operating systems.

Use the following commands to install NICE Engage Platform client-side applications using the
silent installation on workstations running Microsoft Windows 7 (usually from a central
deployment server, such as SMS/SCCM 2007, etc.):

Set Security Application below.

NICE Player and NICE Player Codec Pack on the facing page.

Reporter Viewer on the facing page.

NICE ScreenAgent on the facing page.

Record on Demand on page 32.

PO Client on page 32

NICE Insight to Impact Bridge on page 32

Nice BSF Toolkit on page 32

Set Security Application
Enter in the Command line:
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SetSecurityApp.exe Server <nnnn>

NICE Player and NICE Player Codec Pack
Enter in the Command line:

msiexec /i "Nice Player.msi" /qn

msiexec /i "Nice Player Codec Pack.msi" /qn

Reporter Viewer
Enter in the command line:

ReporterViewer.exe /S /D=<ReporterViewer installation folder>

or

msiexec /i "ReporterViewer.msi" /qn

NICE ScreenAgent
To install NICE ScreenAgent using a silent installation:

1. Copy the NICE ScreenAgent installation folder to a temporary location on the server on which
you want to run the silent installation.

2. Extract the .msi files by running the following command in the Run window:

<Path\Setup.exe file> /t:<Path\target folder> /c

Here <Path\Setup.exe file> is the path to the Setup file in the NICE ScreenAgent installation folder
and <Path\target folder> is the path to the folder to which you want to extract the .msi files.

IMPORTANT

You must leave a space (not an underscore) after <path to Setup.exe file> and after
<target folder> .

This command extracts two .msi files to the target folder:

screenagentxp.msi - (32-bit installation)

screenagentxp64.msi - (64-bit installation)

3. To install the NICE ScreenAgent software, run one of the following procedures (for details
about configuring the parameters see Configuring NICE ScreenAgent Installation Parameters, in
the ScreenAgent Installation and Configuration Guide):

If you are running the silent installation locally on each client machine, in the Run
window, run the following command:

msiexec.exe /i <full path to .msi file> /q SYSADMIN = <Application Server Host Name>

4: Microsoft Client Operating Systems
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Important!

You must leave a space (not an underscore) after msiexec, after /i, after <full path to
.msi file>, and after q.

-or-

If you are deploying NICE ScreenAgent using a publishing application, configure the
publishing application to run the relevant .msi file.

NOTE:

You can use any publishing application that supports .msi files.

After completing the installation, you configure the NICE ScreenAgent in the System
Administrator.

Record on Demand
Enter in the Command line:

msiexec /i "RODSetup.msi" /qn SERVERURL=<nnnn> LAUNCH="No" ALLUSERS=1

in which “nnnn” is the Host Name

PO Client
Enter in the command line:

msiexec /i "Full path to the NICE Real-Time Client.msi" /qn STANDALONE="1"
EGDEFAULTP="full path for project.XML"

NICE Insight to Impact Bridge
Enter in the command line:

msiexec /i "full path to the NICE Insight to Impact Bridge.msi file" /qn EGHOST="
Application Server HostName "

Nice BSF Toolkit
For NICE Engage Platform, in the Command line, enter the following:

msiexec /i "NICE BSF Toolkit.msi" /qn

Configuration Guide - Cross-Release
Third Party Technical Guidelines (H1) - 32 -

4: Microsoft Client Operating Systems

Record on Demand



Manually Installing Client Applications
NOTE:

The procedures listed below are applicable to NICE Engage Platform 6.x client-
side components on workstations running Microsoft Windows 7 32-bit or 64-bit
operating systems.

Keep in mind that:

In NICE Engage Platform 6.x, UAC can be turned on during the
installation of the client-side applications.

To install client-side applications on workstations with Microsoft Windows 7:

1. Locate the application installation directory.

The default path for NICE Player, NICE Player Codec Pack, Reporter Viewer, and Record on
Demand is:
\\server_name\...\Program Files\NICE Systems\Applications\Client Side Applications

2. Copy the required application installation file(s) to the local computer.

3. Log in to the workstation using a User with Administrative privileges.

4. Refer to Windows 7 32-bit/64-bit on page 29 to see if the component requires that the UAC be
turned Off. If the UAC can remain on, run the installation wizard.

If the UAC must be turned off, do one of the following:

If you logged in under the Built-in Administrator, in the Local Group Policy Editor
window, set the User Account Control: Admin Approval Mode for the Built-in
Administrator policy to Disabled.
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Figure 4-1: Local Group Policy Editor Window

If you logged in under another user with Administrative privileges, in the Local Group
Policy Editor window, set the User Account Control: Run all administrators in Admin
Approval Mode policy to Disabled.

Figure 4-2: Local Group Policy Editor Window

5. Run the installation wizard.
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Windows 8 and Windows 8.1 32-bit/64-bit

Client Applications Compatibility
NICE Engage Platform 6.x supports the following editions of Microsoft Windows 8 and Microsoft
Windows 8.1, in both 32-bit and 64-bit configurations:

Microsoft Windows 8 Professional Edition

Microsoft Windows 8 Enterprise Edition

Microsoft Windows 8.1 Professional Edition

Microsoft Windows 8.1 Enterprise Edition

The following table shows the compatibility of NICE Engage Platform 6.x client applications with
Microsoft Windows 8/8.1:

Application
Windows 8
32-bit

Windows 8
64-bit

Windows 8.1
32-bit

Windows 8.1
64-bit

Screen Agent Approved Approved Approved Approved

ROD Approved Approved Approved Approved

Standalone NICE Player
and NICE Player Codec
Pack

Approved Approved Approved Approved

Reporter Viewer Approved Approved Approved Approved

NICE Applications
(including Set Security)

Approved Approved Approved Approved

Survey Manager Not
Supported

Approved Not
Supported

Not Supported

VRA Approved Approved Approved Approved

Media Library Approved Approved Approved Approved

Table 4-2: Compatibility With Microsoft Windows 8 and 8.1 32-bit and 64-bit for Engage Platform 6.x
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Application
Windows 8
32-bit

Windows 8
64-bit

Windows 8.1
32-bit

Windows 8.1
64-bit

BSF Tool Kit Approved Approved Approved Approved

NICE Sentinel Remote
Client

Not
Supported

Approved Not
Supported

Approved

Real-Time Designer

NOTE:

The Real-Time Designer
cannot be installed on
Windows 8/8.1 in VMware
view.

The Real-Time Designer
requires .NET Framework 4
to be installed side-by-side
with .NET Framework 4.5
(the Windows 8/8.1
default).

Approved Approved Approved Approved

Real-Time Client

NOTE:

The Real-Time Client
requires .NET Framework 4
to be installed side-by-side
with.NET Framework 4.5
(the Windows 8/8.1 default)

Approved Approved Approved Approved

Table 4-2: Compatibility With Microsoft Windows 8 and 8.1 32-bit and 64-bit for Engage Platform 6.x (con-
tinued)

Using the Silent Installation to Install Client
Applications
Use the following commands to install NICE Engage Platform client-side applications with the
silent installation on workstations running Microsoft Windows 8 and Windows 8.1:

NICE Player and NICE Player Codec Pack on the facing page

NICE Screen Agent on the facing page

Record on Demand on page 38
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NICE Player and NICE Player Codec Pack
This topic describes how to install the NICE Player and NICE Player Codec Pack.

To use NICE Player and NICE Player Codec Pack:

At the command-line prompt, type:

msiexec /i "Nice Player.msi" /qn

msiexec /i "Nice Player Codec Pack.msi" /qn

NICE Screen Agent
This section describes how toinstall NICE ScreenAgent by using the silent installation Use one of
the following methods:

Run the silent installation locally on each client machine on which you want to install NICE
ScreenAgent.

Use a publishing application to deploy NICE ScreenAgent on all the client machines.

To install NICE ScreenAgent using a silent installation:

1. Copy the NICE ScreenAgent installation folder to a temporary location on the server where
you want to run the silent installation.

2. Extract the .msi files by running the following command in the Run window:

<Path\Setup.exe file> /t:<Path\target folder> /c

where <Path\Setup.exe file> is the path to the Setup file in the NICE ScreenAgent installation
folder and <Path\target folder> is the path to the folder with the .msi files to be extracted.

This command extracts two .msi files to the target folder:

screenagentxp.msi - (32-bit installation)

screenagentxp64.msi - (64-bit installation)

3. To install the NICE ScreenAgent software, run one of the following procedures:

For local manual installation, in the Run window on each client machine, type the
following command:

msiexec.exe /i <full path to .msi file> /q SYSADMIN = <Application Server Host Name>

NOTE:
You must leave a space (not an underscore) after <path to Setup.exe file> and after
<target folder>.
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You must leave a space (not an underscore) after msiexec, after /i, after <full path to .msi
file>, and after q.

Or

For a batch installation, configure the publishing application to run the relevant .msi
file.

NOTE: You can use any publishing application that supports .msi files. After completing the
installation, configure the NICE ScreenAgent in the System Administrator.

Record on Demand
This topic describes how to install the Record on Demand application.

To use Record on Demand:

At the command-line prompt, type the following:

msiexec /i "RODSetup.msi" /qn SERVERURL=<nnnn> LAUNCH="No" ALLUSERS=1

Where nnnn is the Host Name.

Manually Installing NICE Client Applications
NOTE: The procedures listed below are applicable to all NICE Engage Platform client-side
components on workstations running Microsoft Windows 8/8.1 operating systems.

In NICE Engage Platform systems, UAC can be turned on while installing client-side
applications.

To manually install NICE client-side applications on workstations with Microsoft
Windows 8 or Microsoft Windows 8.1:

1. Log in to the workstation with a valid user with administrative privileges.

2. Locate the application installation directory. The default path for NICE Player, NICE Player
Codec Pack, Reporter Viewer, and Record on Demand is:

\\server_name\...\Program Files\NICE Systems\Applications\Client Side Applications

3. Copy the required application installation file(s) to the local computer.

4. Run the installation wizard.
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Windows 10 32-bit/64-bit
NICE Engage Platform Release 6.x supports Windows 10. This section provides information on
Microsoft Windows 10 Operating system, both in the 32-bit and 64-bit versions.

Windows 10 Client Applications Compatibility
From NICE Engage 6.4 and up, Microsoft Windows 10 Professional Edition and Windows 10
Enterprise Edition are compatible with NICE client applications, in both 32-bit and 64-bit
configurations.

Application

Windows 10 Pro Windows 10 Enterprise

32-bit 64-bit 32-bit 64-bit

Screen Agent Approved Approved Approved Approved

Record on Demand/Stop on
Demand

Approved Approved Approved Approved

Standalone NICE Player and
NICE Player Codec Pack

Approved Approved Approved Approved

Reporter Viewer Approved Approved Approved Approved

QM Apps Approved Approved Approved Approved

Survey Manager Not approved Not approved Not approved Not approved

VRA Not approved Not approved Not approved Not approved

Media Library Not approved Not approved Not approved Not approved

BSF Tool Kit Approved Approved Approved Approved

NICE Sentinel Remote Client Approved Approved Approved Approved

Real-Time Designer Approved Approved Approved Approved

Real-Time Client Approved Approved Approved Approved

Table 4-3: Compatibility with Microsoft Windows 10 32-bit and 64-bit for NICE Engage Platform 6.x
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Application

Windows 10 Pro Windows 10 Enterprise

32-bit 64-bit 32-bit 64-bit

NDM/SRT/RHT Approved Approved Approved Approved

Engage Search Approved Approved Approved Approved

Analytics Apps Approved Approved Approved Approved

High Availability Manager Not approved Not approved Not approved Not approved

NICE Web Applications Approved Approved Approved Approved

Table 4-3: Compatibility with Microsoft Windows 10 32-bit and 64-bit for NICE Engage Platform 6.x (con-
tinued)

Using the Silent Installation to Install Client
Applications
Use the following commands to install NICE Engage Platform client-side applications with the
silent installation on workstations running Microsoft Windows 10:

Reporter Viewer

NICE Player and NICE Player Codec Pack on the facing page

Record on Demand on the facing page

NICE BSF Toolkit on the facing page

RTI Client on the facing page

NICE Insight to Impact Bridge on the facing page

Reporter Viewer

To install the Reporter Viewer Application:

1. In the command-line prompt, enter the following command:

ReporterViewer.exe /S /D=<ReporterViewer installation folder>

or

msiexec /i "ReporterViewer.msi" /qn

2. After installing the Reporter Viewer, install the SAP Business Object BI platform located in the
following folder:
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C:\Program Files (x86)\Nice Systems\Reporter Viewer\32bitCA\32bit

In a silent installation BI platform, enter the following command:

setup.exe –r response.ini /q

NICE Player and NICE Player Codec Pack

To install the NICE Player and NICE Player Codec Pack:

In the command-line prompt, enter the following command:

msiexec /i "Nice Player.msi" /qn

msiexec /i "Nice Player Codec Pack.msi" /qn

Record on Demand

To install the Record on Demand:

At the command-line prompt, type the following:

msiexec /i "RODSetup.msi" /qn SERVERURL=<nnn> LAUNCH="No" ALLUSERS=1

Where nnn is the Host Name.

NICE BSF Toolkit

To install the NICE BSF Toolkit:

In the command-line prompt, enter the following command:

msiexec /i "NICE BSF Toolkit.msi" /qn

RTI Client

To install the RTI Client:

In the command-line prompt, enter the following command:

msiexec /i "Full path to the NICE Real-Time Client.msi" /qn
STANDALONE="1" EGDEFAULTP="full path for project.XML"

NICE Insight to Impact Bridge

To install the NICE Insight to Impact Bridge

In the command-line prompt, enter the following command:
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msiexec /i "full path to the NICE Insight to Impact Bridge.msi file" /qn
EGHOST=" Application Server HostName"

Manually Installing NICE Client Applications
NOTE: The procedures listed below are applicable to all NICE Engage Platform client-side
components on workstations running Microsoft Windows 10 operating system.

In NICE Engage Platform systems, UAC can be turned on while installing client-side
applications.

To manually install NICE client-side applications on workstations with Microsoft
Windows 10:

1. Log in to the workstation with a valid user with administrative privileges.

2. Locate the application installation directory. The default path for NICE Player, NICE Player
Codec Pack, Reporter Viewer, and Record on Demand is:

\\server_name\...\Program Files\NICE Systems\Applications\Client Side Applications

3. Copy the required application installation file(s) to the local computer.

4. Run the installation wizard.
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Windows 11 64-bit
NICE Engage Platform Release 6.7 and up supports Windows 11. This section provides information
on Microsoft Windows 11 Operating system 64-bit version.

Windows 11 Client Applications Compatibility
From NICE Engage 6.7 and up, Microsoft Windows 11 Pro Edition and Windows 11 Enterprise
Edition are compatible with NICE client applications.

Important! Before using Windows 11 Pro or Enterprise Editions with supported browsers,
configure the required browser. See Enabling IE Mode for Microsoft Edge Chromium on
page 56 or Adding the IE Tab to Google Chrome on page 79.

Application
Windows 11 Pro
64-bit

Windows 11
Enterprise 64-bit

ScreenAgent Approved Approved

Record on Demand/Stop on Demand Approved Approved

Standalone NICE Player and NICE Player Codec Pack Approved Approved

Reporter Viewer Approved Approved

QM Apps Approved Approved

Survey Manager Not approved Not approved

VoIP Recording Agent (VRA) Not approved Not approved

Media Library Approved Approved

BSF Tool Kit Approved Approved

NICE Sentinel Remote Client Approved Approved

Real-Time Designer Not approved Not approved

Table 4-4: Compatibility with Microsoft Windows 11 NICE Engage Platform 6.x
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Application
Windows 11 Pro
64-bit

Windows 11
Enterprise 64-bit

Real-Time Client Not approved Not approved

NDM/SRT/RHT Approved Approved

Engage Search Approved Approved

Analytics Apps Approved Approved

High Availability Manager Approved Approved

NICE Web Applications Approved Approved

Table 4-4: Compatibility with Microsoft Windows 11 NICE Engage Platform 6.x (continued)

Using the Silent Installation to Install Client
Applications
Use the following commands to install NICE Engage Platform client-side applications with the
silent installation on workstations running Microsoft Windows 11:

Reporter Viewer

NICE Player and NICE Player Codec Pack on the facing page

Record on Demand on the facing page

NICE BSF Toolkit on the facing page

RTI Client on the facing page

NICE Insight to Impact Bridge on the facing page

Reporter Viewer

To install the Reporter Viewer Application:

1. In the command-line prompt, enter the following command:

ReporterViewer.exe /S /D=<ReporterViewer installation folder>

or

msiexec /i "ReporterViewer.msi" /qn
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2. After installing the Reporter Viewer, install the SAP Business Object BI platform located in the
following folder:

C:\Program Files (x86)\Nice Systems\Reporter Viewer\32bitCA\32bit

In a silent installation BI platform, enter the following command:

setup.exe –r response.ini /q

NICE Player and NICE Player Codec Pack

To install the NICE Player and NICE Player Codec Pack:

In the command-line prompt, enter the following command:

msiexec /i "Nice Player.msi" /qn

msiexec /i "Nice Player Codec Pack.msi" /qn

Record on Demand

To install the Record on Demand:

At the command-line prompt, type the following:

msiexec /i "RODSetup.msi" /qn SERVERURL=<nnn> LAUNCH="No" ALLUSERS=1

Where nnn is the Host Name.

NICE BSF Toolkit

To install the NICE BSF Toolkit:

In the command-line prompt, enter the following command:

msiexec /i "NICE BSF Toolkit.msi" /qn

RTI Client

To install the RTI Client:

In the command-line prompt, enter the following command:

msiexec /i "Full path to the NICE Real-Time Client.msi" /qn
STANDALONE="1" EGDEFAULTP="full path for project.XML"

NICE Insight to Impact Bridge

To install the NICE Insight to Impact Bridge

In the command-line prompt, enter the following command:
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msiexec /i "full path to the NICE Insight to Impact Bridge.msi file" /qn
EGHOST=" Application Server HostName"

Manually Installing NICE Client Applications
NOTE: The procedures listed below are applicable to all NICE Engage Platform client-side
components on workstations running Microsoft Windows 11 operating system.

In NICE Engage Platform systems, UAC can be turned on while installing client-side
applications.

To manually install NICE client-side applications on workstations with Microsoft
Windows 11:

1. Log in to the workstation with a valid user with administrative privileges.

2. Locate the application installation directory. The default path for NICE Player, NICE Player
Codec Pack, Reporter Viewer, and Record on Demand is:

\\server_name\...\Program Files\NICE Systems\Applications\Client Side Applications

3. Copy the required application installation file(s) to the local computer.

4. Run the installation wizard.
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5:Internet Explorer

Important!

Microsoft announced that Internet Explorer 11 (IE11) desktop application will be retired on
June 15, 2022.

For more information, see Internet Explorer 11 desktop app retirement FAQ.

NICE Engage Platform is fully compatible with Microsoft Edge Chromium and Google Chrome
browsers.

To continue working in your NICE environment, follow one of these options:

Use the Microsoft Chromium Edge browser in IE mode. This is the official Microsoft
alternative to IE11. Microsoft have stated that they are committed to supporting this
solution until at least 2029.

For more details, see The future of Internet Explorer on Windows 10 is in Microsoft Edge.

To configure Microsoft Edge Chromium with IE Mode for Engage, see Microsoft Edge
Chromium with IE Mode on page 53 .

Use the Google Chrome browser with IE Tab. IE Tab is a certified extension to Chrome from
Blackfish Software that fully supports IE11.

For more details, see IE Tab - Run Internet Explorer Inside Chrome.

To configure Google Chrome with the IE Tab Extension for Engage, see Google Chrome with
the IE Tab Extension on page 75.

Contents

Internet Explorer 11 48
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Internet Explorer 11
This section describes compatibility of Internet Explorer 11 with NICE Web Applications.

Compatibility of NICE Web Applications with
Internet Explorer 11 32, 64-bit

Product NICE Engage Platform, NICE Sentinel, NICE Advanced Process
Automations, Engage Search

Release NICE Sentinel:

NICE Sentinel Remote Client: R6.x.

NOTE: Internet Explorer works with Sentinel Remote Client
only when using compatibility mode (Compatibility mode is
the Microsoft Internet Explorer default mode). For more
information, see the Sentinel Installation and Configuration
Guide.

NICE Advanced Process Automation

Synopsis Windows 10 Professional 32/64-bit (from Engage 6.4 and up)

Windows 10 Enterprise 32/64-bit (from Engage 6.4 and up)

Windows 8.1 Professional 32/64-bit

Windows 8.1 Enterprise 32/64-bit

Windows 7 Professional SP1 32/64-bit

Windows 7 Enterprise SP1 32/64-bit

Windows 7 Ultimate SP1 32/64-bit

Windows Server 2008 R2 SP1 Standard Edition 64-bit

Windows Server 2008 R2 SP1 Enterprise Edition 64-bit

Windows Server 2012 R2 Standard 64-bit

Windows Server 2012 R2 Datacenter 64-bit

Prerequisite Updates for Internet Explorer 11
During the installation of Internet Explorer 11 for Windows 7 SP1 or Windows Server 2008 R2 SP1,
prerequisite components are installed as well. If the prerequisite components cannot be installed,
the installation stops. In this case, install the following prerequisite updates manually:

KB2729094
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KB2731771

KB2533623

KB2670838

KB2786081

KB2834140

General Description and Conclusions
General tests were performed using Internet Explorer 11 (IE11) with NICE Engage Platform 6.x.

Conclusions

The NICE Engage Platform is compatible with all tested operating systems with the following
limitations:

Run only one NICE Engage Platform Applications Suite per browser.

Use XBAP with the Windows 8.1 and Windows 7 client systems only.

For Internet Explorer 11 on Windows 10, Windows 8.1 and Windows 7, you must have NICE
Engage Platform 6.x.

See NICE Web Applications Known Issues with Internet Explorer 11 on the next page.

Using XBAP with Internet Explorer
When using XBAP, the Tool menu disappears from the Internet Explorer tool bar. To view
the tool menu, you can do one of the following:

Open a new tab. The Tools menu will be available in the new tab.

Click the Internet Options button in Internet Explorer and use the Internet Options
window. If this button does not appear, right-click in the Button bar and add it.

The URL address to any NICE Engage Platform projects you were using will be different
when using XBAP.

Instead of the ASPX link http://<server
name>/NiceApplications/Desktop/webpage/DeskTopWebForm.aspx, the new address will
be
http://<server name>/NiceApplications/Desktop/XbapApplications/NiceDesktop.XBAP.

NICE Engage Platform 6.x is designed to work only with XBAP, but not with ASPX.

If you previously created shortcuts/favorites, then replace all previously saved links to the new
address.

For more information on setting up XBAP, see theWorkstation Setup Guide
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NICE Web Applications Known Issues with
Internet Explorer 11

Important!

NICE Applications and the Set Security feature support only the 32-bit version of Internet
Explorer.

The following section describes known issues when using Internet Explorer 11:

When the NICE Application Server is identified as an Internet site, the following message may
appear:

NICE Applications Suite requires Microsoft.NET framework version 3.5 or higher Installed on this
computer. Install the proper version and restart the Web browser.

Configuring Internet Explorer 11 to Disable
Protected Mode
Perform the following procedure to configure Internet Explorer 11 to disable Protected Mode.

To disable Protected Mode:

1. Run Internet Explorer 11. Right-click the Internet Explorer icon, and select Run as Admin.

2. On the Menu Bar, select Tools, and then Internet Options.

The Internet Options windows appears:
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Figure 5-1: Internet Options Window

3. Click the Security tab. In the Security level for this zone area, make sure that Enable Protected
Mode is not selected.

4. Click OK.

5: Internet Explorer

Configuring Internet Explorer 11 to Disable Protected Mode

Configuration Guide - Cross-Release
Third Party Technical Guidelines (H1) - 51 -



[This page intentionally left blank]



6:Microsoft Edge Chromium with IE Mode
This section describes compatibility of the Microsoft Edge Chromium browser in IE Mode with
NICE Web Applications.

Contents

Compatibility of NICE Web Applications with Microsoft Edge Chromium in IE Mode 54
Enabling IE Mode for Microsoft Edge Chromium 56
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Compatibility of NICE Web Applications
with Microsoft Edge Chromium in IE Mode

Browser Support Policy

Microsoft Edge
Chromium

Latest supported public version

IE Mode

Product NICE Engage Platform, NICE Sentinel, NICE Advanced Process
Automation, Engage Search, NICE Playback Portal, Compliance
Center

Release NICE Engage Platform 6.x

Compliance Center 8.9 and above

NICE Sentinel:

NICE Sentinel Server

NICE Sentinel Remote Client

Synopsis Windows 10 Pro 32/64-bit

Windows 10 Enterprise 32/64-bit

Windows 8.1 Professional 32/64-bit

Windows 8.1 Enterprise 32/64-bit

Windows 7 Professional SP1 32/64-bit

Windows 7 Enterprise SP1 32/64-bit

Windows 7 Ultimate SP1 32/64-bit

Windows Server 2012 R2 Standard 64-bit

Windows Server 2012 R2 Datacenter 64-bit

Windows Server 2016

Windows Server 2019

Windows 11 Pro 64-bit

Windows 11 Enterprise 64-bit
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Client Application Compatibility
The following table shows the NICE Engage Platform 6.x client applications compatible with the IE-
Tab extension in Microsoft Edge Chromium.

Application
IE Tab (Version 9.5.2.1, 13.x, 14.x) Extension
in Google Chrome (Version 49 and above)

Analytics Apps Approved

NICE Web Applications Approved

QM Apps Approved

RTA Approved

Engage Search Approved

Reporter Approved

NICE Sentinel Remote Client Approved

NICE Playback Portal Approved

Engage Search Approved

Compliance Assurance Approved

Policy Manager Approved

Fraudster Exposure Approved

Authentication spotlight Approved
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Enabling IE Mode for Microsoft Edge
Chromium
This section describes how to use Edge Chromium in IE Mode to access NICE Web Applications.
This is necessary because Edge Chromium does not support ActiveX controls, Browser Helper
Objects, VBScript, or other legacy technology. To access the NICE Web Applications that use this
technology, you can configure Edge Chromium to automatically load these sites in IE Mode.

Before you configure Edge Chromium with IE Mode, make sure that all your workstations have the
latest version of Edge Chromium as well as IE11, as IE Mode utilizes Internet Explorer
components.

Enabling IE Mode in Edge Chromium includes the following steps:

1. Configuring the Edge Chromium Policy Settings on Windows below

2. Configuring the Internet Explorer Integration Policy on page 58

3. Configuring the Enterprise Mode Site List on page 60

4. Configuring the Enterprise Mode Site List Policy on page 62

5. Disabling download file type extension-based warnings for xbap file types on domain on
page 66

6. Configuring the Standards Mode Site List Policy on page 68

7. Testing the IE Mode Configuration on page 70

8. IE Mode Limitations on page 73

Configuring the Edge Chromium Policy Settings on Windows
You can use group policy objects to configure policy settings for Microsoft Edge Chromium. To
configure Edge Chromium with group policy objects, you have to install administrative templates:

Depending on your Platform, select the latest stable Channel/Version, Build, and click GET
POLICY FILES to download the Microsoft Edge policy templates file from Download and
deploy Microsoft Edge for business.

Depending on your Platform, select the latest stable Channel/Version, Build, and click
DOWNLOAD to download the latest Microsoft Edge version.
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The policy template files add rules and settings for Microsoft Edge to the group policy in your
Active Directory domain or to the Policy Definition template folder on your individual computer, as
described in:

To Add the Administrative Template to the Active Directory: below

To Add the Administrative Template to an Individual Computer: on the next page

To Add the Administrative Template to the Active Directory:

1. On a domain controller or workstation with RSAT, browse to the PolicyDefinition folder (also
known as the Central Store) on any domain controller for your domain.

For older versions of Windows Server, you may need to create the PolicyDefinition folder. For
more information, see How to create and manage the Central Store for Group Policy
Administrative Templates in Windows.

2. Open MicrosoftEdgePolicyTemplates, and go to windows > admx.

3. Copy the msedge.admx file to the PolicyDefinition folder. (Example:
%systemroot%\sysvol\domain\policies\PolicyDefinitions)

4. In the admx folder, open the appropriate language folder. For example, if you’re in the U.S.,
open the en-US folder.

5. Copy the msedge.adml file to the matching language folder in the Policy Definition folder.
Create the folder if it does not already exist. (Example:
%systemroot%\sysvol\domain\policies\PolicyDefinitions\EN-US)

6. If your domain has more than one domain controller, the new ADMX files will be replicated to
them at the next domain replication interval.

7. To confirm the files loaded correctly, open the Group Policy Management Editor from
Windows Administrative Tools and expand Computer Configuration > Policies >
Administrative Templates > Microsoft Edge. You should see one or more Microsoft Edge
nodes as shown below.
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8. Continue with Configuring the Internet Explorer Integration Policy below.

To Add the Administrative Template to an Individual Computer:

1. On the target computer, open MicrosoftEdgePolicyTemplates, and go to windows > admx.

2. Copy the msedge.admx file to your Policy Definition template folder. (Example:
C:\Windows\PolicyDefinitions)

3. In the admx folder, open the appropriate language folder. For example, if you’re in the U.S.,
open the en-US folder.

4. Copy the msedge.adml file to the matching language folder in your Policy Definition folder.
(Example: C:\Windows\PolicyDefinitions\en-US)

5. To confirm the files loaded correctly either open Local Group Policy Editor directly (Windows
key + R and enter gpedit.msc) or open MMC and load the Local Group Policy Editor snap-in. If
an error occurs, it’s usually because the files are in an incorrect location.

6. Continue with Configuring the Internet Explorer Integration Policy below.

Configuring the Internet Explorer Integration Policy
To enable IE Mode in Edge Chromium you need to configure the Internet Explorer integration
settings in the group policy.
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To configure the Internet Explorer integration policy:

1. In the Group Policy Management Editor, browse to Policies > Administrative Templates
Policy definitions > Microsoft Edge.

2. Click Configure Internet Explorer integration. The Configure Internet Explorer integration
window appears.
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3. Select the Enabled radio button, then, in the Options area select Internet Explorer mode
from the dropdown menu.

4. Click Apply, then click OK to close the Configure Internet Explorer integration window.

5. Continue with Configuring the Enterprise Mode Site List below.

Configuring the Enterprise Mode Site List
The Enterprise Mode Site List XML file lists the sites and domains that should automatically be
opened in IE Mode in Edge Chromium.

To configure the Enterprise Mode Site List:

1. Download and install the Enterprise Mode Site List Manager (schema v.2):
https://www.microsoft.com/en-us/download/details.aspx?id=49974.
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2. Open the Enterprise Mode Site List Manager application .

The Enterprise Mode Site List Manager for v.2 schema window appears.

3. Click Add. The Add new website window appears.
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4. Enter the following information:

a. In the URL field, enter your Engage FQDN without http or https. The Enterprise Mode Site
List Manager tool automatically attempts to run both versions during the validation of the
URL. If you are in an AD FS environment, you need to add the FQDN of the Federation
Service name.

b. From the Open In dropdown menu, select IE11.

c. Ensure the Standalone IE check box and the Allow Redirect check box are unchecked.

d. From the Compat Mode dropdown menu, select IE 11 Document Mode.

e. Click Save. The Enterprise Mode Site List Manager window appears with the list of sites
you selected to open in IE Mode.

5. Select File, then select Save to XML.

6. Copy the xml file to the Application server in the folder C:\inetpub\wwwroot.

7. Continue with Configuring the Enterprise Mode Site List Policy below.

Configuring the Enterprise Mode Site List Policy
To enable IE Mode in Edge Chromium you need to configure the Enterprise Mode Site List policy
settings in the group policy.
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To configure the Enterprise Mode Site List Policy:

1. In the Local Group Policy Editor (gpedit.msc), under Computer Configuration, browse to
Administrative Templates > Microsoft Edge.

2. Click Configure the Enterprise Mode Site List. The Configure the Enterprise Mode Site List
window appears.
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3. Select the Enabled radio button, then in the Options area enter the location of your site list.

NOTE: The location of your site list is in the Registry Editor: HKEY_LOCAL_
MACHINE\Software\Policies\Microsoft\Edge\

For example:
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4. Click Apply, then click OK to close the Configure the Enterprise Mode Site List window.

5. Open Microsoft Edge, in the address bar, enter edge://compat/enterprise, then click Force
update.

The Enterprise Mode Site List is updated.

6. Continue with Disabling download file type extension-based warnings for xbap file types on
domain on the next page.
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Disabling download file type extension-based warnings for xbap file types on
domain
For more information, see Disable download file type extension-based warnings for specified file
types on domains.

To disable download file type extension-based warnings for xbap file types on domain:

1. In the Local Computer Policy, under Computer Configuration, browse to Administrative
Templates > Microsoft Edge.

2. Double-click Disable download file type extension-based warnings for specific file types on
domains. The Disable download file type extension-based warnings for specific file types on
domains window appears.
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3. Select the Enabled radio button, then in the Options area click Show.

The Show Contents window appears.
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4. In the Value field, enter the following value:

[ { "file_extension": "xbap", "domains": ["nicevm-49-197/Nice"] }

where "nicevm-49-197/Nice" is the NICE Engage URL.

5. Click OK.

6. Click Apply, then click OK to close the Disable download file type extension-based warnings
for specific file types on domains window.

7. Continue with Configuring the Standards Mode Site List Policy below.

Configuring the Standards Mode Site List Policy
To enable IE Mode in Edge Chromium you need to configure the Standards Mode Site List policy
settings in the group policy.

To configure the Standards Mode Site List Policy:

1. In the Local Group Policy Editor (gpedit.msc), under Computer Configuration, browse to
Administrative Templates > Windows Components > Internet Explorer > Compatibility
View.
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2. Double-click Turn on Internet Explorer Standards Mode for local intranet. The Turn on
Internet Explorer Standards Mode for local intranet window appears.

3. Select the Enabled radio button.

4. Click Apply, then click OK to close the Turn on Internet Explorer Standards Mode for local
intranet window.

5. Continue with Testing the IE Mode Configuration on the next page.
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Testing the IE Mode Configuration
After configuring the Group Policy, check that the specified NICE Engage URL opens in IE Mode in
Edge Chromium.

To test the IE Mode configuration:

1. Verify that the NICE Engage URL is added to the Trusted sites in Internet Properties:

a. Go to Internet Options.

b. Click the Security tab.

c. Click the Trusted sites icon.

d. Click the Sites button.

e. Enter the NICE Engage URL in the Add this website to the zone field.

f. Click Add to add the website to the list.
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g. Click Close to close the Trusted sites dialog box.

NOTE: If you are in an SSL environment, from the Internet Options, you need to select the
Advanced tab, then select the Security options and clear the Do not save encrypted
pages to disk checkbox.

h. Click OK to apply your changes and close the Internet Options window.

2. Open Edge Chromium and log in to Engage: https://ENGAGE_FQDN/Nice.

If the IE Mode configuration is working, the Internet Explorer favicon will appear on the left
side of the navigation bar:

When you click the Internet Explorer favicon, the following information appears:

6: Microsoft Edge Chromium with IE Mode

Enabling IE Mode for Microsoft Edge Chromium

Configuration Guide - Cross-Release
Third Party Technical Guidelines (H1) - 71 -

https://engage_fqdn/Nice


3. In the Application Run - Security Warning window, click Run.

4. Log in to Engage.
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NOTE: If the following error message appears, you do not have all the required Windows
updates. See the prerequisites listed in About IE mode for the required versions of
Windows and Edge Chromium.

IE Mode Limitations
Using multiple browser types at the same time, on the same workstation, is not supported in
Engage 6.x. For example, Microsoft Edge and Google Chrome can't both be open and in use on the
same workstation, at the same time.
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7:Google Chrome with the IE Tab Extension
This section describes compatibility of the Google Chrome browser with the IE Tab Extension with
NICE Web Applications.

Contents

Compatibility of NICE Web Applications with the IE Tab Extension in Google Chrome 32/64-
bit 76
Adding the IE Tab to Google Chrome 79
NICE Web Applications Known Issues with the IE Tab in Google Chrome 88
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Compatibility of NICE Web Applications
with the IE Tab Extension in Google Chrome
32/64-bit

Browser Support Policy

Google Chrome Latest supported public version

IE-Tab

Product NICE Engage Platform, NICE Sentinel, NICE Advanced Process
Automation, Engage Search, NICE Playback Portal, Compliance
Center

Release NICE Engage Platform 6.x

NICE Sentinel:

NICE Sentinel Server

NICE Sentinel Remote Client

Synopsis Windows 10 Pro 32/64-bit

Windows 10 Enterprise 32/64-bit

Windows 8.1 Professional 32/64-bit

Windows 8.1 Enterprise 32/64-bit

Windows 7 Professional SP1 32/64-bit

Windows 7 Enterprise SP1 32/64-bit

Windows 7 Ultimate SP1 32/64-bit

Windows Server 2012 R2 Standard 64-bit

Windows Server 2012 R2 Datacenter 64-bit

Windows Server 2016

Windows 11 Pro 64-bit

Windows 11 Enterprise 64-bit
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General Description and Conclusions
General tests were performed using the IE Tab extension in Google Chrome with Engage Platform
6.x.

The NICE Engage Platform is compatible with all tested operating systems with the following
limitations:

You should run only one NICE Engage Platform Applications Suite per browser.

You should only use the XBAP technology with the Windows 7, Windows 8.1, Windows 10,
or Windows 11 client systems.

Client Application Compatibility
The following table shows the NICE Engage Platform 6.x client applications compatible with
Microsoft Edge Chromium in IE Mode.

Application
IE Tab (Version 9.5.2.1, 13.x, 14.x) Extension
in Google Chrome (Version 49 and above)

Analytics Apps Approved

NICE Web Applications Approved

QM Apps Approved

RTA Approved

Engage Search Approved

Reporter Approved

NICE Sentinel Remote Client Approved

NICE Playback Portal Approved

Engage Search Approved

Compliance Assurance Approved

Policy Manager Approved

Fraudster Exposure Approved
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Application
IE Tab (Version 9.5.2.1, 13.x, 14.x) Extension
in Google Chrome (Version 49 and above)

Authentication spotlight Approved
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Adding the IE Tab to Google Chrome
The IE Tab is an extension that allows you to emulate Internet Explorer, while working in Google
Chrome.

To add the IE Tab

1. Install and start Google Chrome.

2. Click the Customize and Control button and select Settings.

3. In the Settings window, open the Extensions tab.
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4. Click the Main menu icon.

5. Click the Open Chrome Web Store tab.
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6. In the Search field, type in "IE Tab" and press Enter.

7. In the Search results, find the IE Tab extension and click to open.

8. Click the Add to Chrome button.
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9. In the dialog box that appears, click Add extension.

10. Click the Extensions icon, select Pin extension, then click the IE Tab button.

The IE Tab button is added to the Tool bar.

11. The ietabhelper.exe file is automatically downloaded.
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12. Open the ietabhelper.exe file and click Run.

13. The IE address bar is added to Google Chrome.

14. Click the Settings button ( ).

The IE Tab Options and Settings window opens. Scroll down to the IE Compatibility Mode
area and select IE 11 Standard Mode.
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15. Verify that the NICE Engage URL is added to the Trusted sites in Internet Properties:

a. Go to Internet Options.

b. Click the Security tab.

c. Click the Trusted sites icon.

d. Click the Sites button.

e. Enter the NICE Engage URL in the Add this website to the zone field.
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f. Click Add to add the website to the list.

g. Click Close to close the Trusted sites dialog box.

NOTE: Note: If you are in an SSL environment, from the Internet Options, you need to
select the Advanced tab, then select the Security options and clear the Do not save
encrypted pages to disk checkbox.

h. Click OK to apply your changes and close the Internet Options window.

7: Google Chrome with the IE Tab Extension

Adding the IE Tab to Google Chrome

Configuration Guide - Cross-Release
Third Party Technical Guidelines (H1) - 85 -



16. Verify that the Internet Explorer Standards Mode for local intranet is on:

a. In the Local Group Policy Editor (gpedit.msc), under Computer Configuration,
browse to Administrative Templates > Windows Components > Internet Explorer >
Compatibility View.

b. Double-click Turn on Internet Explorer Standards Mode for local intranet. The Turn
on Internet Explorer Standards Mode for local intranet window appears.

c. Select the Enabled radio button.
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d. Click Apply, then click OK to close the Turn on Internet Explorer Standards Mode for
local intranet window.

17. Open Google Chrome and click the IE Tab button that appears to the right of the address bar
on the tool bar.

18. In the address bar enter the Engage URL (https://ENGAGE_FQDN/Nice).

19. Log in to Engage.

20. In the Application Run - Security Warning window click Run.
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NICE Web Applications Known Issues with
the IE Tab in Google Chrome
1. Sentinel Web Client doesn’t support Compatibility Mode. However, for IE-Tab it is turned on by

default.

To disable the Compatibility Mode:

a. Right-click the IE Tab button and select Options.

b. Open the IE Compatibility Mode window and select the Internet Explorer version you
want Google Chrome to emulate.

2. Using multiple browser types at the same time, on the same workstation, is not supported in
Engage 6.x. For example, Microsoft Edge and Google Chrome can't both be open and in use on
the same workstation, at the same time.
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8:Microsoft .NET Framework

This section provides information, support, and solutions for Microsoft .NET Framework.

Contents
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NICE Support for Microsoft .NET Framework

Product .NET Framework Support

Release NICE Engage Platform 6.x, NICE Sentinel 6.x

Synopsis This section describes support for Microsoft .NET Framework
(versions 3.0, 3.5, 4.0, 4.5.2, 4.6/4.6.1, 4.7/4.7.1/4.7.2, and 4.8) by
NICE products, for NICE Engage Platform 6.x, NICE Sentinel 6.x

Overview
This section provides information regarding NICE products support for Microsoft .NET Framework
(versions 3.0, 3.5, 4.0, 4.5.2, 4.6/4.6.1, 4.7/4.7.1/4.7.2, and 4.8).

Microsoft .NET Framework Server-Side Support
The following table lists the NICE release versions and indicates which version supports Microsoft
.NET Framework (versions 3.0, 3.5, 4.0, 4.5.2, 4.6/4.6.1, 4.7/4.7.1/4.7.2, and 4.8)

Release Version Status

Approved for all environments, except Playback Organizer version 2.

Table 8-1:
NICE Release Versions support Microsoft .NET Framework - Server-Side
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Release Version Status

NICE Engage
Platform 6.x

.NET 3.5 Service Pack 1 is required

.NET 4.0 is required

.NET 4.5 is approved

.NET 4.5.1 is approved

.NET 4.5.2 is approved

(Engage 6.4 and below) .NET Framework 4.6./4.6.1/4.6.2 is approved

(Engage 6.5 and above) .NET 4.6./4.6.1/4.6.2 Framework is required

.NET 4.7/4.7.1/4.7.2 is approved

(For Compliance Center only) .NET 4.7.2 is required on the Applications
Server

.NET 4.8 is approved

.NET 6.x side-by-side with .NET 4.x is approved

See the Certified Servers Guide for more details about requirements.

NICE Sentinel
6.x

.NET 3.5 Service Pack 1 is required

.NET 4.5 is required

.NET 4.5.1/4.5.2 is approved

.NET 4.6/4.6.1 is approved

.NET 4.7/4.7.1/4.7.2 is approved

.NET 4.8 is approved

Table 8-1: NICE Release Versions support Microsoft .NET Framework - Server-Side (continued)

Microsoft .NET Framework Client-Side Support
The following table lists the NICE release versions and indicates which version supports Microsoft
.NET Framework (Versions 3.0, 3.5, 4.0, 4.5, 4.5.1, 4.5.2, 4.6/4.6.1, 4.7/4.7.1/4.7.2, and 4.8).
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Release Version Status

NICE Engage
Platform 6.x

.NET 3.5 Service Pack 1 is required

.NET 4.0 is required

.NET 4.5 is approved

.NET 4.5.1 is approved

.NET 4.5.2 is approved

(Engage 6.4 and below) .NET Framework 4.6./4.6.1/4.6.2 is approved

(Engage 6.5 and above) .NET 4.6./4.6.1/4.6.2 Framework is required

.NET 4.7/4.7.1/4.7.2 is approved

.NET 4.8 is approved

.NET 6.x side-by-side with .NET 4.x is approved

See the Certified Servers Guide for more details about requirements.

NICE Sentinel
6.x

.NET 3.5 Service Pack 1 is required

.NET 4.5 is required

.NET 4.5.1/4.5.2 is approved

.NET 4.6/4.6.1 is approved

.NET 4.7/4.7.1/4.7.2 is approved

.NET 4.8 is approved

Table 8-2:
NICE Release Versions support Microsoft .NET Framework - Client-Side
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Figure 8-1: .NET Framework Developer’s Guide
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Microsoft .NET Framework 4.6
Requirements
NICE Engage Platform 6.5 and up requires Microsoft .NET Framework version 4.6. .NET Framework
version 4.6 must be installed on all servers and clients in the site. See Certified Servers Guide for a
complete list.

Ensuring the Correct XBAP Version
In order for .NET Framework 4.6 to work optimally with XBAP, the newest version of XBAP must be
installed. If updating a previous version of NICE Engage Platform to Release 6.5, it is required to
delete the previously installed XBAP version. At the next login, the new version of XBAP will be
installed automatically.

To ensure the correct XBAP version:

Navigate to C:\Users\<username>\AppData\Local, and delete the Apps folder.

At the next login to NICE Engage Platform, the new version of XBAP will be installed
automatically.
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9:Microsoft SQL Server

This section describes support for the various Microsoft SQL Server versions.

Contents
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SQL Server 2014 97
SQL Server 2016 98
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SQL Server 2012

Product NICE Engage Platform, NICE Sentinel

Release NICE Engage Platform 6.x

Advanced Process Automation

NICE Sentinel 6.X

For more information see:

Microsoft SQL Server - Requirements and Best Practices

Microsoft Cluster Installation for NICE Environments
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SQL Server 2014

Product NICE Engage Platform

Release NICE Engage Platform 6.x

NICE Sentinel 6.x

For more information see:

Microsoft SQL Server - Requirements and Best Practices

Microsoft Cluster Installation for NICE Environments
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SQL Server 2016

Product NICE Engage Platform

Release NICE Engage Platform 6.x

NICE Sentinel 6.x

SQL 2016 Standard/Enterprise was certified for the Database Server and Data Mart. Only clean
installation is supported. There is no migration/upgrade from previous SQL versions.

For more information see:

Microsoft SQL Server - Requirements and Best Practices

Microsoft Cluster Installation for NICE Environments
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10:Additional Third Party Components

This section outlines the additional third party components and their supported versions used by
NICE Engage Platform.

Contents
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Apache Solr
Apache Solr is an open-source enterprise-search platform, written in Java. NICE Engage Platform
uses Apache Solr for stored interactions and metadata that are sent to Engage Search.

Below are the supported Apache Solr versions:

Apache Solr Version NICE Engage Platform Release

Apache Solr 7.1.0 NICE Engage Release 6.7, 6.10, 6.12, 6.15

Table 10-1:
Apache Solr
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Apache Tomcat
NICE Engage Platform uses Apache Tomcat to implement Java Servlet and run the Java-based
applications.

Below are the supported Apache Tomcat versions:

Apache Tomcat Version NICE Engage Platform Release

Apache Tomcat 9.0.35 NICE Engage Release 6.7 SP21, 6.10 SP15, 6.12 SP11, 6.15
SP5

Table 10-2:
Apache Tomcat
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ActiveMQ
Apache ActiveMQ is an open source, multi-protocol, Java-based messaging server. NICE Engage
Platform uses ActiveMQ for Application Servers, Real- Time Servers, ITIC Servers and Advanced
Process Automation (APA).

NICE Engage Platform supports these ActiveMQ versions for NICE Engage Platform.

ActiveMQ Version
NICE Engage Platform
Release NICE Engage Components

ActiveMQ 5.15.3 - 5.16.1 NICE Engage Release 6.7, 6.10,
6.12, 6.15

Applications Server

ITIC server

To update ActiveMQ:

1. Download the latest version ActiveMQ from the Apache site
https://activemq.apache.org/download.

2. Go to the run window, and enter service.msc. The Services window opens.

3. Right-click ActiveMQ, and click Stop to stop the service.
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4. Back up apache-activemq-<existing version number> folder.

5. Open <install_dir>\Program files\NICE Systems\ActiveMQ\apache-activemq--<existing
version number>\bin\win64, and run the UninstallService.bat file.

6. Delete the apache-activemq--<existing version number> folder from <install_dir>\Program
files\NICE Systems\ActiveMQ\.

7. Extract the apache-activemq--<new version number>-bin.zip file to a temporary directory, and
copy the extracted folder to <install_dir>\Program files\NICE Systems\ActiveMQ\.

8. Open the <install_dir>\Program files\NICE Systems\ActiveMQ\apache-activemq-<new
version number>\bin\win64 folder, and run the InstallService.bat file.

9. Go back to the backup folder of the existing ActiveMQ version before the upgrade inStep 4,
and copy the conf folder.

10. Go to the <install_dir>\Program files\NICE Systems\ActiveMQ\apache-activemq-<new version
number>\, and replace the conf folder with the one copied in Step 9.

11. Go back to Services. The Services window opens.
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12. Right-click ActiveMQ service, and then select Properties. The Properties window appears.
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13. Click the Log On tab, and in the Log on as section:
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a. Select This account, and enter the same account as the Application service.

b. Enter the same password as the Application service, and confirm it.

c. Click Apply, and close the window.

14. Go back to Services, and start the ActiveMQ service.
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SAP Products
SAP products are used by NICE Engage Platform in the NICE Reporter application to generate and
view reports. Crystal Report deployment includes Oracle JAVA instance.

Below are the supported SAP versions:

NICE Engage
Platform
Release

NICE
Reporter
Viewer
(Online
/Offline)

NICE Reporter Server NICE Reporter Server and
Client Workstations

NICE Engage
Release 6.x

09.27.75.07 SAP Crystal Reports Server
2013 SP10, OEM Edition
14.1.10.2483

SAP BO BI Platform .NET SDK
4.1 SP10 14.1.10.2483

Table 10-3: Reporter Viewer Versions
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IBM Integration Bus (IIB)
NICE Engage Platform uses IBM Integration Bus (IIB) and IBM WebSphere MQ to transfer and save
interactions in ..\NICE Systems\SplashData folder in .csv and .man format.

Below are the supported IBM Integration Bus and IBM WebSphere MQ versions:

IIB/MQ Version NICE Engage Platform Release

IIB 10.0.0.3 NICE Engage Release 6.7

MQ 8.0.0.0

IIB 10.0.0.4 NICE Engage Release 6.10

MQ 8.0.0.0

IIB 10.0.0.13 NICE Engage Release 6.12

NICE Engage Release 6.15
MQ 8.0.0.10

Table 10-4:
IIB/MQ
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11:Microsoft Kerberos Configuration Manager
Microsoft Kerberos Configuration Manager for SQL Server is a diagnostic tool for troubleshooting
Kerberos-related connectivity issues with SQL Server.

The tool performs these functions:

Gathers information about the operating system and Microsoft SQL Server instances
installed on a server.

Generates reports about all SPN and delegation configurations on the server.

Identifies potential issues in SPNs and delegations.

Repairs potential SPN issues.

The tool requires .NET framework 4.0 or higher.

Supported Operating Systems
Microsoft Kerberos Configuration Manager for SQL Server supports these operating systems:

Windows 7/8/10

Windows Server 2008 R2 SP1/ 2012/ 2016

To configure Kerberos using Microsoft Kerberos Configuration Manager for SQL Server:

1. Download Microsoft Kerberos Configuration Manager for SQL Server from the Microsoft
website.

2. After the installation is complete, go to ...ProgramFiles\Microsoft\Kerberos Configuration
Manager for SQL Server.

3. Right-click KerberosConfigMgr.exe, and click Run as different user.

Configuration Guide - Cross-Release
Third Party Technical Guidelines (H1) - 109 -

11



The Run as different user window appears.

4. Enter the user name and password of the user with privileges to fix the SPN on the server, and
click OK. The main Kerberos Configuration Manager for SQL Server appears.
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5. Click Connect. The Connect to Server window appears.
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6. In the Connect to Server window:

a. For a remote instance, enter the Server name for the Windows Authentication server,
User name and Password .

For a local instance, keep all of the fields empty.

b. Click Connect.

7. After connecting to the instance, click the SPN tab, and select the relevant check boxes to filter
the results.

8. Check the status of the registered SPNs. If the status of any of the SPNs is Missing, click Fix for
specific SPNs or Fix All to fix all of the ones that are missing.
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A warning appears.
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9. Click Yes to start fixing the SPN.

If the SPN is fixed, the status converts to Good, and the procedure is complete

If you receive a permissions error as shown below, continue to Step 10.
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10. This step should only be performed if you receive a permissions error. Create a script, and run
it as a user with privileges to fix the SPN on the server.

a. Go to the SPN tab, and click Generate to generate a script for specific SPNs or Generate
All to generate scripts for all of the SPNs that are missing.

b. Save the script in your desired location.
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c. Right-click the file with the script, and click Run as different user.

The Run as different user window appears.
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d. Enter the user name and password of the user with privileges to fix the SPN on the server,
and click OK. The cmd.exe will open.

e. For the question Are you sure you want to continue?, enter Y to fix the SPN.
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12:Microsoft Security Bulletins

This section describes Microsoft security bulletins.

Contents

KBs Delivered by Microsoft and NICE Certification Policy 120
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KBs Delivered by Microsoft and NICE
Certification Policy
Microsoft launched a new policy in October 2016 where security and non-security packages are
released in a cumulative rollup in addition to security update bulletins.

Security update bulletins are approved by NICE on a monthly basis.

Rollups released by Microsoft are not approved by NICE.

Package Windows 7 SP1,
Windows 8.1, Windows
Server 2008 R2,
Windows Server 2012,  
Windows Server 2012
R2 (with supported IE
versions)

Windows 10
(with
supported IE
versions and
.NET
Framework)

.NET
Framework

SQL

Separate security
KBs

KB
delivered
by
Microsoft
and
certified by
NICE

One KB package
with security only

Includes KBs that
are relevant and
non-relevant to
NICE

KB delivered by
Microsoft and certified
by NICE

KB delivered
by Microsoft
and certified
by NICE

Monthly rollup KB
(includes security
and non-security)
Includes KBs that
are relevant and
non-relevant to
NICE

KB delivered by
Microsoft

KB delivered
by Microsoft
and certified
by NICE

KB delivered
by Microsoft
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13:Federal Information Processing Standards
(FIPS)
Federal Information Processing Standards (FIPS) are publicly announced standards developed by
the U.S. federal government for use in computer systems by non-military government agencies
and government contractors. They were issued to establish requirements for various purposes
such as ensuring computer security and interoperability.

The U.S. government developed a variety of FIPS specifications to standardize a number of topics
including:

Codes such as standards for encoding data (e.g., country codes or codes to indicate
weather conditions or emergency indications).

Encryption standards, such as the Data Encryption Standard (FIPS 46-3) and the
Advanced Encryption Standard (FIPS 197).

Contents

Configuring Windows for FIPS 122
FIPS Verification Flow 124
Spell Check Limitation 125
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Configuring Windows for FIPS
The FIPS mode can be applied on the server or client machine in one of two ways:

It can be part of the domain policy.

It can be manually configured on the server or client machine.

To manually apply FIPS mode on the machine:

1. Open the Local Security Policy by selecting Start -> Administrative tools->Local Security
Policy. Run the Local Security Policy under a user that has privileges to edit the local policy.

2. In the open window, change the security settings. Navigate to Security Settings->Local
Polices->Security Options and select System Cryptography: Use FIPS compliant algorithms
for encryption, hashing and signing (disabled by default).
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3. Restart all of the servers and clients whose FIPS mode was activated.
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FIPS Verification Flow
As part of the Engage Media Encryption solution, we use the AesCryptoServiceProvider class in the
Media Encryption Framework (MEF) component. The AesCryptoServiceProvider class is a FIPS 140-
2 compliant wrapper of the Microsoft Crypto API, used in Engage for:

Encryption keys and VI generation

Data encryption

Data decryption

NICE Engage Platform 7.x installed on Windows Server 2016 and Windows Server 2019 uses the
Enhanced Cryptographic Provider library (RSAENH.DLL), a FIPS 140-2 compliant cryptographic
module. The Enhanced Cryptographic Provider library is responsible for verifying that encryption
algorithms are FIPS compliant when AesCryptoServiceProvider class is used.

In Windows Server 2019, each call to the Enhanced Cryptographic Provider library routs an API call
into the FIPS-certified CNG libraries (or in recent Windows releases to the Kernel Mode
Cryptographic Primitives Library) that check and indicate if the specific call is FIPS compliant.
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Spell Check Limitation
For secured sites running Insight Manager, Form Designer, Lexicon Manager and Business
Analyzer, spell check functionality is not available when FIPS is enabled on the system.

Users will receive the following error when activating the spell check:

Spell check is not available since FIPS (Federal Information Processing Standards) is enabled
on this system.
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14:Microsoft Daylight Savings Time Updates
This section provides the Microsoft Daylight Savings Time (DST) updates supported by NICE
Systems.

For Microsoft Daylight Savings Time configurations, see the Maintenance Guide.

Supported in: Microsoft DST Updates

NICE Engage Platform 6.x KB 951072, KB 955839, KB 970653, KB 976098, KB 981793,

KB 2158563, KB 2443685, KB 2570791, KB 2633952,

KB 2756822, KB 2779562, KB 2863058, KB 2974661,

KB 2984350, KB 2967990, KB 2981580, KB 2998527,

KB 3011843, KB 3013410, KB 3049874, KB 3062741,

KB 3062740, KB 3077715, KB 3093503, KB 3112148,

KB 3148851, KB 3153731, KB 3162835, KB 3148851,

KB 3153731, KB 3162835, KB 3177723, KB 3182203,

KB 3192321, KB 3203884, KB 4015193, KB 4012864,

KB 4023136, KB 4020322, KB 4486459, KB 4501226,

KB 4507704, KB 4519108, KB 4484172, KB 4557900

Table 14-1: Microsoft DST Updates
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15:Antivirus

This section includes installation instructions and limitations for Antivirus products on client
computers and loggers.

NOTE: The information in this section refers to software versions only. In addition,
customers, business partners, and services must verify that the servers and Loggers meet
the minimum hardware requirements as defined by the third party software vendor.

Contents

General Antivirus 130
General Antivirus Configuration Guidelines 140
Antivirus Software Configuration 148
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General Antivirus
Antivirus Certifications for NICE Products below

Antivirus Certifications for NICE Products

Product Antivirus Certifications for NICE Products

Release

Synopsis This section includes general instructions and limitations for
Antivirus Certifications for NICE Products, NICE Products and
Antivirus Certifications matrices, as well as procedures for
installing antivirus products on client computers and Loggers.

General Instructions
A list of general instructions follows:

During the installation of the antivirus software, all applications and screens must be
closed.

The same applies when upgrading the antivirus software.

Scan and Live Updates should be scheduled to run in system idle time.

Do not run Scan or Live Update during NICE software installation.

Always set Scan Priority to Low.

General Limitations
To avoid playback, performance, and retention issues, the destination paths of all Storage
Units must be excluded from antivirus scans. See the System Administrator - Configuration
Guide- for more information regarding setting up Storage Units.

When installing an antivirus on a cluster, take the following guidelines into account:

The antivirus software should be cluster-aware. An application is cluster-aware if it has
the following characteristics:

It uses TCP/IP as a network protocol.

It maintains data in a configurable location.

It supports transaction processing.

On the clustered servers, Microsoft recommends excluding the following folders from
antivirus scanning:
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The path of the \mscs folder on the quorum hard disk. For example, exclude the
Q:\mscs folder from virus scanning.

The %Systemroot%\Cluster folder.

The temp folder for the Cluster Service account. For example, exclude the
\clusterserviceaccount\Local Settings\Temp folder from virus scanning.

McAfee ePO
McAfee ePO 5.10 works with McAfee Antivirus 8.8

Make sure that when using ePO for Microsoft patches update, the configured policy
matches the NICE policy concerning Microsoft Windows updates and Service packs.

McAfee
Make sure to clear the option to install the McAfee firewall. Do not install the firewall, as it
would cause network problems.

It is recommended to set the CPU Utilization for the On Demand Scan in McAfee AV to 10%.

The McAfee’s VirusScan version 8.0 feature Buffer Overflow Protection does not allow
applications to overflow the buffer, including the CLS Log Manager. This causes the Log
Manager to write logs (Channel server, Call server etc.) with a very long delay, or not write
them at all. Therefore this feature should be disabled for all machines running CLS. See
also to TN0640 McAfee ePO 3.5 and McAfee Antivirus Certification for NICE 8.80.

McAfee Limitation:

Memory Scan process in McAfee 8.5/8.7 on some TDM Loggers can cause the system to
crash with BSOD. This problem was resolved in McAfee 8.7 Patch 3, and in later versions,
but still exists in McAfee 8.5.

Do not use versions earlier than McAfee 8.7 Patch 3 on servers with TDM Loggers.

SEP
NICE Products support Symantec Endpoint Protection.

In some cases, SEP 12.1 and up can detect NICE or even Microsoft binaries as malware and
place them in the Quarantine folder. To prevent false-positive detection, follow the
recommendations available in the Symantec white paper Sizing and Scalability
Recommendations for Symantec Endpoint Protection (http://clientui-
kb.symantec.com/resources/sites/BUSINESS/content/staging/DOCUMENTATION/4000/
DOC4448/en_
US/1.0/Endpoint%20Protection%20Sizing%20and%20Scalability%20Best%20Practices_%
20v2.3.pdf).

Exceptions can be added from within the Symantec Endpoint Protection Manager console to
provide false-positive mitigation on the client. For example, you can do the following:
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Exclude your domain from Insight detection.

Figure 15-1: Exceptions Window

NOTE: You can select Trusted Web Domain, to add a Web domain to the exceptions policy.
Add exclusions or exceptions for critical files, folders, URLs, and IP addresses.

NOTE: When you add exceptions, you can select more than one application, file, URL, or IP
address at a time.
A known-good application can appear in the Risk Logs as a false-positive. You can configure
log settings to allow the application and thereby prevent it from appearing in the Risk Log.
This same functionality is also available in the SONAR Logs.
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Figure 15-2: Risk Logs Window

For more information, see the Symantec Endpoint Protection and Symantec Network Access
Control Implementation Guide.

SEP Limitations
Starting with SEP (Symantec Endpoint Protection) version 12.1.2 and up, the SEP firewall causes
issues with Microsoft Cluster setup and functionality. To avoid this issue change the SEP settings
to allow IP traffic.

To change the SEP settings:

1. Open Symantec Endpoint Protection (SEP).
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2. In the left column, click Change Settings. The Change Settings area appears on the right.
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3. In the Network Threat Protection area, click Configure Settings. The Network Threat
Protection Settings window appears.

4. In the Firewall tab, in the Unmatched IP Traffic Settings area, select Allow IP traffic. By
default, Allow only application traffic is selected.

5. Click OK.

6. Restart your computer.

Trend Micro
Trend Micro AV requires that the NICE servers belong to the same domain.

Sophos
Sophos Exclusions: In a NICE Engage Platform 6.x and up site with Sophos antivirus
deployed, before beginning to use NDM to install or update the site, add psexec.exe to
Exclusions list. Otherwise, it can cause a problem with running NDM Agents.

(http://www.sophos.com/en-us//threat-center/threat-analyses/adware-and-
puas/PsExec.aspx).
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Microsoft Defender Antivirus
Microsoft Defender Antivirus is an anti-malware component of Microsoft Windows. It is built into
Microsoft Windows and works with Microsoft Defender for Endpoint to provide protection on
devices and in the cloud.

Microsoft Defender Antivirus is the major component of the next-generation protection in
Microsoft Defender for Endpoint. This protection combines machine learning, big-data analysis,
in-depth threat resistance research, and the Microsoft cloud infrastructure to protect devices (or
endpoints) in your organization.

Supported operating systems:

Windows 10 or up

Windows Server 2022

Windows Server 2019

Windows Server version 1803 or up.

Versions: from 1.371.120.0 and up.

NOTE: In NICE Engage Platform 6.x, Microsoft Defender Antivirus is supported only for
Windows 2016.
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Antivirus Matrixes for NICE Products
Third-Party Software is approved per NICE product for all operating systems certified by NICE.

NICE Engage 6.x Antivirus Support

NICE Products

SEP McAfee Trend Micro Sophos

Microsoft
Defender
Antivirus

11.00

14

ePO

5.10 8.8 OfficeScan 11/XG 10.7/10.8 1.371. 1651.0.

TDM Logger Y Y Y Y Y Y

VoIP Logger Y Y Y Y Y Y

Interactions Server Y Y Y Y Y Y

NiceScreen Logger Y Y Y Y Y Y

Playback Server / Telephony
Services Server (incl. NICE
Feedback)

Y Y Y Y Y Y

Table 15-1:
NICE Products and Antivirus Certifications Matrix - NICE Engage Platform 6.x
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NICE Products

SEP McAfee Trend Micro Sophos

Microsoft
Defender
Antivirus

11.00

14

ePO

5.10 8.8 OfficeScan 11/XG 10.7/10.8 1.371. 1651.0.

Storage Center Y Y Y Y Y Y

Media Library Y Y Y Y Y Y

Application Server Y Y Y Y Y Y

Audio Analysis Server Y Y Y Y Y Y

ScreenSense Server Y Y Y Y Y Y

Reporter Y Y Y Y Y Y

Database Server Y Y Y Y Y Y

Sentinel Y Y Y Y Y Y

RTA - Enrollment Engine Y Y Y Y Y Y

Table 15-1: NICE Products and Antivirus Certifications Matrix - NICE Engage Platform 6.x (continued)
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NICE Products

SEP McAfee Trend Micro Sophos

Microsoft
Defender
Antivirus

11.00

14

ePO

5.10 8.8 OfficeScan 11/XG 10.7/10.8 1.371. 1651.0.

RTA - RTVA, Authentication
Engine

Y Y Y Y Y Y

RTA - Authentication and Fraud
Engine (Nuance) audio folder

Y Y Y Y Y Y

RTA - RTIM Y Y Y Y Y Y

RTA - ITIC Y Y Y Y Y Y

Advanced Interaction Recorder Y Y Y Y Y Y

* In some cases SEP 12 can detect NICE’s binaries as a potential security risk.
For further details, see Antivirus Matrixes for NICE Products on page 1.

Table 15-1: NICE Products and Antivirus Certifications Matrix - NICE Engage Platform 6.x (continued)
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General Antivirus Configuration Guidelines
This section includes guidelines for general configuration of antivirus software running on NICE Perform servers. These guidelines are
designed to allow better performance and operation of the NICE system and generally apply to any antivirus software.

Customers, business partners, and NICE engineers should use these guidelines for configuring or verifying the configuration of antivirus
software.

NOTE: These guidelines are provided for NICE server performance. Customers should make their own risk analysis while
implementing these guidelines.

Overview 141
Antivirus Real Time Scan 141
Daily Scan 141
Weekly Scan 141
Folders and Files Exclusion 141
Disabling Firewalls 145
Allowing Required Email Messages 146
Live Updates 146
CPU Priority 146
Additional Configurations 146
Additional Recommendations 147
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Overview
NICE Systems supports two approaches for antivirus software certification: proactive certification
or by using the guidelines in this section.

As part of the proactive approach NICE Systems has certified specific antivirus software
applications according to NICE third party software certification policy. For a complete
compatibility list, see the Third Party Technical Guidelines.

Alternatively, you can use the guidelines in this section and use any antivirus software application.
These guidelines are general and designed to ensure the performance of NICE Systems.

Antivirus Real Time Scan
The antivirus scan is a resource consuming action and should not be enabled during working
hours. If Real Time Scan is enabled during working hours, it may cause performance issues and
interfere with standard system operations.

NICE does not recommend using real time scanning due to numerous risks including, but not
limited to:

Recording loss

Playback performance degradation

Impact on archiving queue, possibly leading to archiving failures

Daily Scan
Daily scans should be performed during non-working hours. The folders which appear in the
Folders and Files Exclusion should not be scanned.

Weekly Scan
Weekly scans should be performed during weekends when the system is idle. Idle time is
dependent upon Storage Center and Interactions Analytics load. The folders which appear in the
Folders and Files Exclusion can be scanned.

Folders and Files Exclusion
Exclude the folders and files in the tables below from your scheduled antivirus scans (Read &
Write), since they are used for NICE system operations.

All the paths in the tables below are the default installation paths. If you used a different path in
your installation, you must use the same path for the excluded files.

NICE Engage Platform
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NICE Server Default Path Files

Advanced Interaction
Recorder

Package and
binaries folder

D:\Program Files\NICE systems\

Log files folder NiceLogLocation:

D:\Program Files\NICE systems\Logs

Metadata
Management folder

D:\Program Files\NICE systems\ *.s3db*

Recording Folders
(partitions)

User defined path in SRT: <Recording
directory>

*.nmf

Archiving Folders User defined path in SRT: <Archiving
directory>

*.nmf

CTI / VRSP D:\Program files\NICE Systems\CTI

Database E:\<SQL Data Files> MDF files

F:\<SQL Log Files> LDF files

Data Mart E:\<SQL Data Files> MDF files

F:\<SQL Log Files> LDF files

Interactions Center D:\Program Files\NICE Systems\Interactions
Center\Bin

D:\Program Files\NICE Systems\Interactions
Center\Data

D:\Program Files\NICE Systems\Interactions
Center\Log
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NICE Server Default Path Files

Nice Screen Logger E:\MMLStorage

D:\Program Files\Nice Systems\Multimedia
Logger\Datasystem

DAT files

TBL files

NICE Sentinel D:\<SQL Data Files>

D:\<SQL Log Files>

MDF files

LDF files

Playback Portal D:\Program Files (x86)\Nice Systems\NICE
Playback Portal Server

Real Time Authentication

Enrollment Engine D:\Program files\NICE Systems\ *.nmf

Authentication
Engine

D:\Program files\NICE Systems *.nmf

C:\windows\system32\MSMQ *.*

Authentication &
Fraud Engine
(Nuance) audio
folder

User defined path in plugin <Fraudsters audio
file path>

*.nmf

Real Time Insight
Manager

C:\windows\system32\MSMQ *.*

Insight-to-Impact
Connect

Desktop Tagging persistency folder:

D:\Program files\NICE Systems\RTI
Connect\Bin

\RealTimeModeBackUps

*.bkp

DB Writer handler persistency folder:

D\Program files\NICE Systems\RTI
Connect\Bin\ PersistentDBWriterDatabase

*.bkp

*.fsd_alive *.fsd_
dead *.fsd_temp
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NICE Server Default Path Files

Speech to Text Engine D:\<Storage Area>

D:\Program Files\NICE Systems\Nice Content
AnalysisServer

D:\Storage Area for a Content Analysis\Index

Standard Word Search
Server

D:\Program Files\NICE Systems\Nice Content
AnalysisServer\MediaCache

E:\<WorkArea>

Storage Center E:\<SC_Archive_Directory> NMF files

Stream Server with
Windows Media Services

D:\<Publishing _Point_Directory>

Text Analysis Engine E:\<WorkArea>

Text Mining Engine E:\<WorkArea>

NICELog Voice Logger /
VoIP Logger

Windows Server 2008:

C:\ProgramData\NICE Systems\IPCapture

C:\ProgramData\NICE Systems\Logger

The raw partition

Log files

C:\Documents and Settings\All
Users\Application Data\Nice

C:\Documents and Settings\All
Users\Application Data\NICE Systems

The unformatted partition

Log files

All operating systems:

D:\Ntlogger

Engage Search
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NICE Server Default Path Files

Application Server D:\Program files\NICE Systems\IIB

D:\ Program files\NICE
Systems\InsightAmplifier

D:\ Program files\NICE Systems\MiniBus

D:\ Program files\NICE Systems\MQ

D:\ Program files\NICE Systems\Search

D:\ Program files\NICE Systems\SplashData

Solar Server D:\ Program files\NICE Systems\Search

Client-side Component Default Path Files

ScreenAgent C:\Program Files (x86)\NICE
Systems\ScreenAgent

In addition, when any of the NICE servers is configured as a clustered component using Microsoft
Failover Cluster (MSCS), cluster-aware antivirus software must be used, and all files in the
following folders should be excluded from virus scanning on such servers:

The path of the \mscs folder on the quorum drive, for example, the Q:\mscs folder.

The %Systemroot%\Cluster folder.

The temp folder for the Cluster Service account, for example, the
\clusterserviceaccount\Local Settings\Temp folder (only with operating systems preceding
Microsoft Windows Server 2008).

More information can be found at http://support.microsoft.com/kb/250355.

Disabling Firewalls
All antivirus software have integrated firewalls and are installed by default on the systems. Default
firewall settings can cause network issues and negatively impact the functioning of NICE's
software.

To disable firewalls:

The default setting for all integrated antivirus firewall software should be changed from
Enabled to Disabled. See the relevant documentation for this information.
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Allowing Required Email Messages
After McAfee VirusScan Enterprise 8.8 is installed on NICE Engage Platform server using the
default installation options, email messages, in particular, NICE Playback Organizer (PBO) requests
and password recovery messages, cannot be sent from these servers. This occurs because the
McAfee antivirus software blocks all outgoing traffic on port 25 (SMTP communication).

After McAfee VirusScan Enterprise 8.8 is installed on the relevant NICE server, configure the
antivirus software not to block port 25.

To unblock port 25 in McAfee VirusScan Enterprise 8.8:

1. Click Start > All Programs > McAfee > VirusScan Console. The VirusScan Console opens.

2. Right-click Access Protection and click Properties. The Access Protection Properties window
opens.

3. Click the Access Protection tab.

4. Under Categories, select Anti-virus Standard Protection.

5. Clear the check marks in the Block and Report columns for the Prevent mass mailing worms
from sending mail rule.

6. Click OK.

Live Updates
NICE highly recommends that the antivirus software is updated on a daily basis. It is
recommended to schedule the automatic update for a time when the network traffic is low.

Low network traffic refers to customer network and not to NICE Engage Platform system.

CPU Priority
It is recommended to set the CPU usage (utilization) to the lowest value. Note that not all antivirus
software allows configuring the CPU usage (utilization).

Additional Configurations
Buffer overflow protection is a resource consuming application and should therefore be
disabled for all NICE Servers.

If you choose to enable this option, you might experience performance issues in your system.

Heuristic scanning should be disabled in case of performance issues.
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Additional Recommendations
In order to maintain performance of your machines during scans, see Microsoft Virus Scanning
recommendations: http://support.microsoft.com/kb/822158.

This information is provided for reference purposes only.
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Antivirus Software Configuration
This section explains how to configure antivirus software to allow better performance of your
NICE system.

NOTE: These guidelines are provided for NICE server performance. Customers should
make their own risk analysis while implementing these guidelines.

Configuring McAfee VirusScan Enterprise 8.8 148
Configuring Symantec Endpoint Protection 157
Configuring Trend Micro OfficeScan 161
Configuring Sophos 164

Configuring McAfee VirusScan Enterprise 8.8
If you are using McAfee VirusScan Enterprise 8.8, do this:

Disable buffer overflow protection.

Disable heuristic scanning.

Exclude the required folders and files from virus scanning.

Configure an update task.

Disable Blocking Port 25.

Configure the CPU Priority.

Disabling Buffer Overflow Protection
Buffer overflow protection is a resource-consuming feature. Therefore, disable it for all NICE
servers.

To disable buffer overflow protection:

1. Log on to ePolicy Orchestrator.

2. Click Menu > System > System Tree.

3. In the System Tree pane, under My Organization, select your group.

4. Click the Assigned Policies tab.

5. In the Product drop-down list, select VirusScanEnterprise 8.8.0.

Configuration Guide - Cross-Release
Third Party Technical Guidelines (H1) - 148 -

15: Antivirus

Antivirus Software Configuration



6. In the Category column, find Buffer Overflow Protection Policies and then click My Default in
the Policy column next to it.

7. In the Settings for drop-down list, select Server.

8. In the Buffer overflow settings section, clear the Enable buffer overflow protection
checkbox.

9. In the Settings for drop-down list, select Workstation.
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10. In the Buffer overflow settings section, clear the Enable buffer overflow protection
checkbox.

11. Click Save.

12. In the Heuristics section, clear the Find unknown program threats and Find unknown macro
threats checkboxes.

13. Click the Performance tab.
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14. In the Artemis (Heuristic network check for suspicious files) section, in the Sensitivity level
drop-down list, select Disabled.

15. If necessary, click the other tabs and add relevant information.

16. Click Save.

17. Select the task created in the Task Name section and click Next.

18. Schedule the running time of the task as desired and then click Next.

19. Review the task settings and then click Save.

Disabling Heuristic Scanning
Disable heuristic scanning, if it impairs performance.

To disable heuristic scanning:

1. Log on to ePolicy Orchestrator.

2. Click Menu > System > System Tree.

3. In the System Tree pane, under My Organization, select your group.
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4. Click the Assigned Client Tasks tab and then click Actions.

5. In the drop-down menu, click New Client Task Assignment.

6. In the Product drop-down list, select VirusScan Enterprise 8.8.0.

7. In the Task type field, select On Demand Scan.

8. Create a new task, and in Task Name type an appropriate name for it.

9. Click the Scan Items tab.

10. In the Heuristics section, clear the Find unknown program threats and Find unknown macro
threats checkboxes.

11. Click the Performance tab.
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12. In the Artemis (Heuristic network check for suspicious files) section, in the Sensitivity level
drop-down list, select Disabled.

13. If necessary, click the other tabs and add relevant information.

14. Click Save.

15. Select the task created in the Task Name section and click Next.

16. Schedule the running time of the task as desired and then click Next.

17. Review the task settings and then click Save.

Excluding Folders and Files
Exclude the folders and files specified in Folders and Files Exclusion on page 141 from your
scheduled antivirus scans (Read & Write), since they are used for NICE system operations.

To exclude folders and files:

1. Log on to ePolicy Orchestrator.

2. Click Menu > System > System Tree.
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3. In the System Tree pane, under My Organization, select your group.

4. Click the Assigned Client Tasks tab and then click Actions.

5. In the drop-down menu, click New Client Task Assignment.

6. In the Product drop-down list, select VirusScan Enterprise 8.8.0.

7. In the Task type field, select On Demand Scan.

8. Create a new task, and in Task Name type a name for it.

9. Click the Exclusions tab.

10. To add an excluded folder, click Add and specify the path of the folder to exclude.
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11. Repeat Step 10 to define all the necessary exclusions.

12. Click the other tabs and add relevant information if necessary.

13. Click Save.

14. Select the task created in the Task Name section and click Next.

15. Schedule the task as desired and then click Next.

16. Review the task settings and then click Save.

Configuring an Update Task
To configure an update task:

1. Log on to ePolicy Orchestrator.

2. Click Menu > System > System Tree.

3. In the System Tree pane, under My Organization, select your group.

4. Click the Assigned Client Tasks tab and then click Actions.

5. In the drop-down menu, click New Client Task Assignment.
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6. In the Product drop-down list, select McAfee Agent.

7. In the Task type field, select Product Update.

8. Create a new task, and in Task Name type an appropriate name for it.

9. In the Package selection section, select All packages or Selected packages. By default, the
Selected packages option is selected.

10. In the Package types section, select the package types. By default, the Engine and DAT
options are selected.

11. If necessary, configure other options with relevant information.

12. Click Save.
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13. Select the task created in the Task Name section and click Next.

14. Schedule the running time of the task as desired and then click Next.

15. Review the task settings and then click Save.

Disabling Blocking Port 25
To disable Blocking Port 25:

1. Go to Start > All Programs > McAfee > VirusScan Console.

2. Right-click Access Protection and select Properties.

3. Click the Access Protection tab.

4. Under Categories, select Anti-virus Standard Protection.

5. Clear the checkbox in the Block and Report columns for the Prevent mass mailing worms
from sending mail rule.

6. Click OK.

Configuring the CPU Priority
To configure the CPU Priority:

1. Log on to ePolicy Orchestrator.

2. Click Menu > System > System Tree.

3. In the System Tree pane, under My Organization, select your group.

4. Click the Assigned Policies tab.

5. From the list, select Default McAfee Agent Policy.

6. Go to McAfee Agent > General > McAfee Default > General Options.

7. Select Run agent processes at lower CPU priority ( Windows Only).

Configuring Symantec Endpoint Protection
If you are using Symantec Endpoint Protection, do this:
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Disable Heuristic Scanning.

Configure SONAR.

Configure LiveUpdate.

Exclude the required folders and files from virus scanning.

Configure the CPU priority.

Disabling Heuristic Scanning
To disable heuristic scanning with Symantec Endpoint Protection:

1. Log on to Symantec Endpoint Protection Manager.

2. In the left-hand column, click the Policies tab.

3. In the Policies pane, click Virus and Spyware Protection.

4. In the Virus and Spyware Protection Policies pane, click the appropriate policy that you use
from the list.

5. In the Virus and Spyware Protection Policy window, under Windows Settings, click Global
Scan Options.
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6. Clear the Enable Bloodhound(TM) heuristic virus detection checkbox.

7. Click OK.

Configuring SONAR
SONAR provides real-time protection, detecting potentially malicious applications running on your
computers.

SONAR uses heuristics, as well as reputation data to detect emerging and unknown threats.
SONAR provides an additional level of protection on your client computers and complements your
existing antivirus, spyware protection, and intrusion prevention.

If SONAR impairs performance of servers running NICE software, disable it.

If your system requires SONAR to be enabled, configure all exclusions using the guidelines in the
Folders and Files Exclusion on page 141 section.

Configuring LiveUpdate
To configure live update with Symantec Endpoint Protection:

1. Log on to Symantec Endpoint Protection Manager.

2. In the Symantec Endpoint Protection Manager, in the left-hand column, click the Policies tab.

3. In the Policies pane, click LiveUpdate.
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4. In the LiveUpdate Policies pane, on the LiveUpdate Settings tab, click LiveUpdate Settings
policy.

5. Edit the policy as required.

6. In the left-hand pane, expand the Schedule section and set an appropriate time for running
LiveUpdate.

7. Click OK.

Excluding Folders and Files
Exclude the folders and files specified in Folders and Files Exclusion on page 141 from your
scheduled antivirus scans (Read & Write), since they are used for NICE system operations.

To exclude folders and files

1. Log on to Symantec Endpoint Protection Manager.
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2. In the Symantec Endpoint Protection Manager, in the left-hand column, click the Policies tab.

3. Select Extensions.

4. Add an Exceptions policy:

a. Go to Exceptions Policy > Exceptions > Add > Windows Exceptions > Folder/Extensions.

b. Specify a folder/extension.

c. Click OK and then Yes.

d. Select a specific group, where to apply the policy.

e. Click Assign and then Yes.

Configuring the CPU Priority
To configure the CPU priority

1. Log on to Symantec Endpoint Protection Manager.

2. In the Symantec Endpoint Protection Manager, in the left-hand column, click the Policies tab.

3. Select Virus and Spyware Protection.

4. Select an appropriate policy from the policies list.

5. Go to Windows Settings > Administrator-Defined Scans.

6. Select an appropriate scheduled scan.

7. Go to Edit > Scan Detail > Advanced Scanning Option > Tuning.

8. Select Best Application Performance.

Configuring Trend Micro OfficeScan
If you are using Trend Micro OfficeScan, do this:

Configure scheduled updating of the OfficeScan server.

Configure automatic updating of OfficeScan clients.

Exclude the required folders and files from virus scanning.
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Configure the CPU usage.

Configuring Scheduled Updating of the OfficeScan
Server

To configure scheduled updates of the OfficeScan server:

1. Log on to the OfficeScan management console.

2. In the right-hand pane, go to Updates > Server > Scheduled Update.

3. Select Enable scheduled update of the OfficeScan server.

4. In the Components to Update section, select the applicable components.

5. In the Update Schedule section, select Daily (highly recommended) and set the applicable
parameters.

6. Click Save.

Configuring Automatic Update
To configure automatic update of OfficeScan clients:

1. Log on to the OfficeScan Management console.
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2. In the right-hand pane, go to Updates > Networked Computers > Automatic Update.

3. In the Event-triggered Update section, select the checkboxes shown above.

4. In the Schedule-based Update section, select Daily (highly recommended) and set the
required parameters.

5. Click Save.

Excluding Folders and Files
Exclude the folders and files specified in Folders and Files Exclusion on page 141 from your
scheduled antivirus scans (Read & Write), since they are used for NICE system operations.

To exclude folders and files:

1. Log on to the OfficeScan Management console.

2. In the right-hand pane, select Scan Now for All Domains.
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3. Go to Server or servers > Settings >Scan Settings > Select Scan Methods.

4. Define what folders and files to exclude.

5. Click Save.

Configuring the CPU Usage
To configure the CPU usage

1. Log on to the OfficeScan Management console.

2. In the right-hand pane, select Scan Now for All Domains.

3. Go to Server or servers > Settings >Scan Settings > Select Scan Methods.

4. Define the CPU usage level.

5. Click Save.

Configuring Sophos
If you are using Sophos, do this:

Configure scheduled updating.

Exclude the required folders and files from virus scanning.

Disable buffer overflow protection.

Configure scheduled scanning.
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Configuring Scheduled Updating
To configure scheduled updating

1. Open the Sophos Enterprise Console.

2. In the main window, go to Polices > Updating.

3. Create a new policy (or use the default one), right click it and select View/Edit Policy.

4. On the Primary Server tab, click Advanced and select a bandwidth use.

5. On the Schedule tab, enter an appropriate time.

6. Click OK.

Excluding Folders and Extensions
Exclude the folders and extensions specified in Folders and Files Exclusion on page 141 from your
scheduled antivirus scans (Read & Write), since they are used for NICE system operations.

To exclude folders and extensions

1. Open the Sophos Enterprise Console.

2. In the main window, go to Polices > Antivirus and HIPS.

3. Create a new policy (or use the default one), right click it and select View/Edit Policy.

4. Click the Extensions and Exclusions button.

For Extensions:

a. On the Extensions tab, click the Exclude button.

b. Click Add.

c. Add an extension and click OK.

For Folders:

a. On the Windows Extensions tab,click Add.

b. Select and item type drive or folder and specify location.
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Disabling Buffer Overflow Protection
To disable buffer overflow protection

1. Open the Sophos Enterprise Console.

2. In the main window, go to Polices > Antivirus and HIPS.

3. Create a new policy (or use the default one), right-click it and select View/Edit Policy.

4. Select On-access scanning and click Configure.

5. Disable Detect buffer overflows.

6. Click OK.

Configuring Scheduled Scanning
To configure scheduled scanning

1. Open the Sophos Enterprise Console.

2. In the main window, go to Polices > Updating.

3. Create a new policy (or use the default one), right click it and select View/Edit Policy.

4. Under Scheduling Scanning, click Add.

5. Specifying scanning parameters.

6. Click OK.
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16:Remote Connection to Customers
This section includes requirements and recommendations for NICE to connect remotely to
customers.

NICE Requirements
NICE needs a remote connection in place from the first days of the project. The connection needs
to have both high bandwidth and low latency. In addition, it is highly recommended to use a
dedicated machine for this connection.

NICE Recommendations
NICE suggests these methods to connect remotely, in order of preference. The customer needs to
let the NICE Project Manager know of any site requirements:

1. WebEx - In order to connect through WebEx, the customer must open the Webex connection
on their side. Also, playback is not always possible through WebEx. This means that the
customer needs to listen to the recording, or download the files locally to send them to NICE.

2. Microsoft Teams - The customer or NICE can set up the Teams meeting.

3. VPN (on VSphere) - Setup can take from four to six weeks to arrange access through VPN on
VSphere. This option enables a remote connection even when the customer is not present on
the other side.
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17:NICE Third Party Software Certification
Policy
This internal policy outlines the procedures to be carried out by the NICE System QA team in
relation to validation of security related software compatibility with NICE products.

These conducts and procedures aim to:

Assure customers of NICE products that the systems and components of NICE are
compatible with third party software that are likely to be installed in NICE servers and on
client desktops.

Provide clear guidelines regarding compatibility validation and certification processes for
the Professional Services group.

Allow consistent and efficient work by the System QA team.

Reduce time and money spent by NICE on a global level, and ensure efficient use of its
resources.

This commitment involves delicate balances and trade-offs. Therefore, compatibility validation is
limited only to commonly accepted third party software, which directly affects the system’s overall
security and serviceability.

This policy states general technical guidelines and shall not be construed in a manner which shall
impose any type of legal undertaking on NICE. In particular, NICE does not warrant the
compatibility of validated third party software with the NICE products, or that the validated
security related software will operate error-free, or in an uninterrupted fashion.
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NICE Products
For clarity, the tables below list the components that require compatibility validation for the latest
versions of NICE Engage Platform. The validation includes all testing required to ensure that the
normal functionality of the components and of the entire system is not affected by the
introduction of the additional third party software. The compatibility validation testing is related
to the specific version of the third-party software. Validation of a specific version of the third-party
software shall not guarantee the compatibility of any subsequent version of the third-party
software.

The compatibility validation for NICE Engage Platform Release 6.x with the latest service pack
and updates includes the following components:

NO. Component Operating System Version

1. AIR Windows Server 2012*

2. NICE Search Server Windows Server 2012*

3. Applications Server Windows Server 2012*

4. Voice Biometrics Engine Windows Server 2012*

5. Real-Time Voice Biometrics
Server

Windows Server 2012*

6. Cognos Server Windows Server 2012*

7. Database Server Windows Server 2012*

8. Playback Portal Stream
Server

Windows Server 2012*

9. Interactions Center Server Windows Server 2012*

10. ITI Connect Server Windows Server 2012*

11. Media Interconnect Windows Server 2012*

Table 17-1:
NICE Engage Server Side Components
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NO. Component Operating System Version

12. Media Retrieval Server Windows Server 2012*

13. NICE Sentinel Server Windows Server 2012*

14. NICE Stream Server Windows Server 2012*

15. NICE Stream Server (WMS) Windows Server 2008*

16. RCM Server Windows Server 2008*

17. Real Time Insight Manager
Server

Windows Server 2012*

18. Real-Time Streamer Windows Server 2012*

19. RT Database Server Windows Server 2012*

20. RT Server Windows Server 2012*

21. Real-Time Word Search Windows Server 2012*

22. Screen Logger Server Windows Server 2012*

23. Speech to Text Server Windows Server 2012*

24. Storage Center Server Windows Server 2008*

25. Telephony Services Server Windows Server 2012*

26. Unified Recorder Server Windows Server 2012*

27. Voice Biometrics Server Windows Server 2012*

28. VoIP Logger Server Windows Server 2012*

29. Playback Portal Database
Server

Windows Server 2012*

* See appropriate Certified Server Guide

Table 17-1: NICE Engage Server Side Components (continued)
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NO. Component Operating System Version

1. BSF Toolkit Windows 7 SP1, Windows
8/8.1, Windows 10*

2. Screen Agent Windows 7 SP1, Windows
8/8.1, Windows 10*

3. IP Phone Applications Windows 7 SP1, Windows
8/8.1, Windows 10*

4. NICE Player Windows 7 SP1, Windows
8/8.1, Windows 10*

5. ROD/SOD Desktop
Application

Windows 7 SP1, Windows
8/8.1, Windows 10*

6. Reporter Viewer Windows 7 SP1, Windows
8/8.1, Windows 10*

7. Survey Manager Windows 7 SP1, Windows
8/8.1, Windows 10*

8. RT Client Windows 7 SP1, Windows
8/8.1, Windows 10*

9. RT Designer Windows 7 SP1, Windows
8/8.1, Windows 10*

10. Sentinel Client Windows 7 SP1, Windows
8/8.1, Windows 10*

11. VoIP Recording Agent
(VRA)

Windows 7 SP1, Windows
8/8.1, Windows 10*

* See appropriate Certified Server Guide

Table 17-2:
NICE Engage Client Side Components
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Compatibility Validation Policy
All of the NICE products listed in NICE Products on page 170 are validated for compatibility with
the following software:

Commonly used antivirus software (see list on page 178)

New versions of Microsoft Windows Operating System (only under product management
direction)

Microsoft .NET Framework - new versions and service packs

New versions of Microsoft SQL Server (only under product management direction)

Microsoft SQL Server service packs

Microsoft Internet Explorer (IE) - new versions and service packs

Microsoft Windows security patches and service packs

Microsoft Windows security advisory patches

Microsoft Windows Daylight Saving Time (DST) updates

Commonly used third party software:

Patch management tools (see list on page 178)

Remote support tools (see list on page 178)

Customer's hardening guidelines (only under commitment)

The list of NICE products and their components is regularly updated (on a quarterly basis or on
demand) according to the NICE Sunset Policy (refer to the most recent Marketing Note - NICE
Sunset Dates) and the introduction of new NICE products/components and product/component
versions.

When a product version meets its End-of-Mainstream Software Support Date1, it is no longer
validated for any of the above mentioned software, except for Microsoft security patches, security
Advisory patches, Daylight Saving Time updates and service packs, as well as Internet Explorer
updates (but not new versions of Internet Explorer), for which validation for compatibility will
continue until the product version’s End-of-Extended Software Support Date2 is met.

1End-of-Mainstream Software Support Date - The final date when NICE will cease to provide code fixes
and changes for a product version.

2End-of-Extended Software Support Date - The final date when NICE will cease to provide critical code
fixes and changes for a product version. Requests for third-party software certifications may require an
upgrade to a newer minor/major release.
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Validation of the above mentioned software ceases when Microsoft no longer supports the
respective operating system required to run this product version (for example, when Microsoft
ceases to release patches and service packs for the operating system in question)1.

A compatibility matrix of NICE products/components and product/component versions vs.
Microsoft or third party software and software versions is maintained and tested by the System
QA team.

When a new NICE product/component or a new version of a product/component is introduced, it
is added to the compatibility matrix. SeeCompatibility Matrix on page 184

Based on agreement with Product Management, an older version of a product/component or a
third party software may be omitted from the compatibility matrix, in the following cases:

A version is no longer commonly used by NICE customers. For example, an older version of
an antivirus software (two or more years older), will be omitted from the compatibility
matrix since antivirus software is usually replaced once a year with a newer version, and
most customers switch to the newer version shortly after its release.

Both Product Management and R&D view the newer version of a NICE product/component
as an evolutionary (rather than revolutionary) step in the development of the
product/component and the testing of the newer version fully ensures, in high probability,
the compatibility of older versions. Hence, the older version is omitted from the
compatibility matrix.

1The end of support date for Windows 2003 is July 14, 2015. The end of support date for Windows
XP SP2 is April 4, 2014.
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Compatibility Validation Process
The System QA team develops and publishes comprehensive test procedures for each type of
compatibility validation.

The System QA team is in constant contact with local third party software vendors who are
included in the compatibility matrix, and proactively checks for new updates at least once a
month. The System QA team maintains an internal list of planned validations, listing details of
vendors’ software release dates, and the appropriate NICE validation target dates stipulated in
this policy.

In addition, the System QA team can be assigned to validate the compatibility of third party
software that is not included in the compatibility matrix, if requested by Product Management,
and subject to a commitment. The System QA team will be asked to provide a timetable dating
from ARO (After Receipt of Order), and include this one-time validation in its list of planned
validations. In this case, the System QA team will not be required to proactively track and validate
future software version compatibility.

The System QA team notifies the EIS Technical Writing group of expected new compatibility
validations, and regularly informs the Technical Writing group of validation status changes. The
Technical Writing group publishes and maintains this information on the ExtraNICE website. This
information includes the following validation details:

Vendor name

Third party software name

Software version

Software release date – which can also be a future date

Validation completion target date

Validation status. The following status options are applicable: Pending software release,
Pending validation, Under validation, Validated.

Last status update

Comments. The comments may include a link to a relevant technical note.

Upon the completion of the compatibility validation, and no later than 10 business days thereafter
(5 business days in case of validation of Microsoft high risk security patches, see Microsoft
Security Patches on page 17), the System QA team updates the Third Party Technical Guidelines,
specifying the newly validated software. This update may also include validated third party
software limitations and recommended installation guidelines for NICE products. Before
appearing in the Third Party Technical Guidelines, these updates are sent to Product Management
for approval.
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Compatibility Validation by Professional Services
The System QA team develops and publishes comprehensive test procedures (ATP) adequate for
compatibility validation of third part software categories not included in the compatibility matrix,
as listed below:

Antivirus and endpoint protection

Intrusion detection and prevention

File integrity

Log collection

Backup agent

Monitoring agent

Remote access

Patch management and distribution

SOE and customer certified OS build

Third party software not included in the compatibility matrix is validated for compatibility
according and subject to the following process:

1. A Commitment Request is filed by the Solution Engineer responsible for the project, providing
the full details of the project.

2. Product Management evaluates the commitment and forwards it to the System QA team if
required. A detailed test plan (ATP) is provided based on the type of software.

3. Product Management assigns the commitment to the regional Professional Services team,
who provide a timetable dating from ARO, and a cost estimate.

4. When off-site staging is required, the regional Professional Services team takes responsibility
for execution.

5. The Professional Services team runs the ATP on-site, to validate the software compatibility on
NICE servers.

6. The completed ATP is re-submitted to the System QA team for approval. If additional or
repeated testing is required, the System QA team instructs Professional Services accordingly.

7. The System QA team supports the software for the validated version only. Future versions of
the software are not proactively tracked or validated by the System QA team or Professional
Services.
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8. the System QA team makes a reasonable effort, time and money-wise, to diagnose and solve
problems if the arise. If no reasonable solution is diagnosed and/or found, NICE is not held
responsible, and the software is removed from NICE servers.

9. Once verified, a Verification Statement is be published by the Services Manager, describing the
environment in which the verification is applicable. Any change to the environment (including
software upgrades), voids the verification.

17: NICE Third Party Software Certification Policy

Compatibility Validation by Professional Services

Configuration Guide - Cross-Release
Third Party Technical Guidelines (H1) - 177 -



Compatibility Validation Guidelines
These are the guidelines by which all of the NICE products are validated for compatibility with the
following software:

Antivirus Software
The System QA team regularly validates the most commonly used antivirus software. As agreed
with Product Management, this list currently includes:

Symantec AntiVirus Corporate Edition

McAfee VirusScan Enterprise

Trend Micro OfficeScan

Sophos Endpoint Security and Control

Usually, customers replace antivirus software versions soon after the release of a new version by
the vendor. Therefore, the System QA team is required to test and validate only the last two most
recentmajor releases of the above mentioned antivirus software packages. Minor releases are
supported when major releases have been certified. For the complete antivirus compatibility
matrix, see the Antivirus on page 129 section.

Other antivirus software packages may be validated on demand, based on commitment.

The System QA team is in constant contact with the local antivirus software vendors, and
proactively checks for new updates at least once every quarter.

Validation of a new antivirus software version will take place no later than 45 business days after
its general availability.

Microsoft Windows Operating System
The System QA team validates NICE products for compatibility with a newmajor version of
Microsoft Windows Operating System (OS) within 60 business days following the Microsoft
official release. This refers to Windows editions planned to be in use by NICE products, servers,
and clients, under Product Management direction.

Compatibility validation of a new version of Windows OS includes validation of the most recent
available version of Internet Explorer.

Microsoft Service Packs
The System QA team validates NICE products for compatibility with Microsoft service packs within
30 business days following the Microsoft official release.
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Microsoft .NET Framework
The System QA team validates NICE products for compatibility with Microsoft .NET Framework
new versions and service packs within 30 business days following the Microsoft official release.

The System QA team compatibility validation ensures that the normal functioning of NICE
applications is not effected by the new .NET Framework software if installed simultaneously on
the same desktop with the .NET Framework version utilized by NICE applications. This requires
validation on all operating systems supported by NICE applications.

Microsoft SQL Server
The System QA team validates NICE products for compatibility with a newmajor version of
Microsoft SQL Server within 60 business days following the Microsoft official release. This refers
to SQL Server editions planned to be used by NICE products under Product Management
direction.

Microsoft SQL Server Service Packs
The System QA team validates NICE products for compatibility with Microsoft SQL Server service
packs within 30 business days following the Microsoft official release. This includes service packs
for all supported SQL Server editions used by NICE products.

Microsoft Internet Explorer
The System QA team validates NICE products for compatibility with Microsoft Internet Explorer (IE)
Internet browser. Other Internet browsers are currently not supported.

Compatibility validation of Internet Explorer service packs follows the same validation guidelines
for Windows service packs (see Compatibility Validation Guidelines on the previous page).

The System QA team validates NICE products with a newmajor version of Internet Explorer within
30 business days following the Microsoft official release.

Compatibility validation of a new version of Windows Operating System (OS) includes validation of
the most recent available version of Internet Explorer.

Microsoft Security Patches
Microsoft classifies its security patches as follows:

1. Critical

2. Important

3. Moderate

4. Low
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NICE considers Critical and Important security patches as High Risk patches, and Moderate and
Low security patches as Low Risk patches.

According to NICE policy, High Risk patches are validated by the System QA team in an expedited
manner within 5 business days.

Low Risk patches are validated together with high risk patches. For example, if at a given time,
moderate and/or low patches are released with at least one critical or important patch, all patches
will be validated. Otherwise, the low risk patch validation is postponed until the next release of
high risk patches.

The System QA team is registered on the Microsoft site for alerts of security patches releases.
Upon a Microsoft patch release, the System QA team notifies Product Management, Customer
Services and the Technical Writing group, listing patches that are relevant to NICE, and their
expected validation date.

No later than 72 hours after a high risk patch release, the NICE ExtraNICE portal is updated to
inform NICE customers and partners of the expected patch compatibility (content is published in
the Security Bulletins directory).

Information about validated bulletins is published using Excel format. The Excel file will be
updated periodically with new security bulletins. The new bulletins are added to the same
aggregated Excel file.

The Excel file includes bulletins in 3 categories:

1. Bulletins which are certified by NICE: Bulletins that were tested by NICE and approved for
installation.

2. Bulletins which are not relevant for NICE: Bulletins. Bulletins that appear under this section
affect Microsoft components that should not be installed on NICE servers, and as a result,
should NOT be installed. Sample Microsoft components: Domain Controller, DNS server,
Microsoft Office.

3. Bulletins which are not certified by NICE: Bulletins that were tested by NICE and were not
approved for installation.

Microsoft Security Advisory Patches
Microsoft Security Advisory Patches are a supplement to Microsoft Security bulletins, and address
security changes that may not require a security patch, but that may still affect overall security.

NICE considers the Microsoft Security Advisory Patches as Low Risk patches.

According to NICE policy, Low Risk patches are validated by the System QA team , together with
the next High Risk patch release (see Compatibility Validation Guidelines on page 178).
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Microsoft Daylight Saving (DST) Updates
Daylight Saving Time (DST) updates move local time forward one hour ahead of standard time in
the spring and set it back one hour in the fall. Microsoft has established an annual update
schedule for DST updates, with provisions for semi-annual cumulative updates if necessary.

According to NICE policy, DST updates are validated by the System QA team within 45 business
days following the Microsoft official release.

Patch Management Tools
Many NICE customers use patch management tools. Patch management tools allow automatic
deployment of Microsoft patches to enterprise servers, including NICE servers, and to client
desktops.

In many cases, the deployment of a security patch or service pack requires restarting the machine.
The System QA team will test and validate that such reboots forced by the patch management
agents can be properly handled by NICE servers and agents. In particular, NICE servers and agents
must recommence their normal work immediately following a machine restart after a forced
reboot.

Most of the patch management tools allow the setting of rules, as to what is to be installed, when
and where. It is imperative that these settings do not contradict the NICE policy for Microsoft
security patches and service packs, as stated in MN1145. The System QA team will test and
publish recommendations regarding the proper configuration of the patch management tool in
order to conform with the NICE policy.

Given the variety of tools available and lack of consistent requirements by the market, and since
the NICE solution is based on Microsoft Windows technology, the System QA team will validate, by
default, the following Microsoft patch management tool(s):

Microsoft Systems Management Server (latest version).

System Center Configuration Manager (latest version).

Other tools might be added to the list of compatible patch management tools upon demand,
based on commitment or Product Management request.

Validation of a new patch management softwaremajor version takes place no later than
45 business days after its general availability.

Remote Support Tools
NICE is required to support remote support tools, in addition to Symantec pcAnywhere (PCA).

Remote support tools validated by NICE must be able to provide remote support for all NICE
products over VPN, with full screen view, using encrypted session and strong authentication.

By default, the System QA team validates the following remote support tool(s), in addition to
pcAnywhere:

17: NICE Third Party Software Certification Policy

Microsoft Daylight Saving (DST) Updates

Configuration Guide - Cross-Release
Third Party Technical Guidelines (H1) - 181 -



Microsoft Remote Desktop

Other tools might be added to the list of compatible remote support tools upon demand, based
on commitment or Product Management request.

Validation of a new remote support softwaremajor version takes place no later than 45 business
days after its general availability.

Configuration Guide - Cross-Release
Third Party Technical Guidelines (H1) - 182 -

17: NICE Third Party Software Certification Policy

Remote Support Tools



Server Hardening
The System QA team publishes an updated Hardening Guide for Windows 2016 and Windows
2019, for every new release of NICE Engage Platform.

The hardening process is based on the Center for Internet Security (CIS) Standard.

The NICE Hardening Guide accurately describes the minimal set of services, protocols, user rights
assignments, permissions to system resources, and communication ports required to allow
normal functioning of the NICE system.

In certain scenarios, if a customer cannot make the necessary analysis based on the information
provided by NICE, the customer might ask NICE to validate their hardening procedures based on
the customers’ IT department security policies. Such a validation could require special staging of a
testing environment. This validation could be performed by the System QA team and/or NICE
Professional Services in the local region, based on commitment and Product Management
approval.
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Compatibility Matrix
The following table summarizes the response times required for different types of compatibility
validation.

Validation Type Maximum Validation
Response Time

Comment

Antivirus 45 business days Major versions of leading
vendors only (see list on page
178)

Internet Explorer 30 business days Major versions only

Internet Explorer Service Pack 30 business days

.NET Framework 30 business days New versions and service packs

Patch Management 45 business days Major versions of Microsoft tools
only (see page 178)

Remote Support 45 business days Major versions of selected tools
only (see page 178)

Security patch – High-risk 5 business days Preliminary notification on
ExtraNICE within 72 hours of
patch release

Security patch – Low-risk With (next) high risk
security patch

Security Advisory patch With (next) high risk
security patch

Daylight Savings Time update 45 business days

SQL Server 60 business days Major versions – under Product
Management direction

Table 17-3:
Validation Response Times
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Validation Type Maximum Validation
Response Time

Comment

SQL Server Service Pack 30 business days

Windows Operating System 60 business days Major versions – under Product
Management direction

Windows Service Pack 30 business days

Table 17-3: Validation Response Times (continued)
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18:Vulnerability Scanner Guidelines
This section provides guidelines for configuring vulnerability scanner software running on NICE
applications.
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Nessus Vulnerability Scanner
Tenable Network Security Nessus is a security software application that allows you to perform
vulnerability scanning of infrastructure with automatic scan analysis for remediation prioritization,
configuration auditing and compliance checks.

Follow the below guidelines to improve your system performance and prevent recording loss,
when running Nessus scans.

Advanced Interaction Recorder and VoIP Logger
A full Nessus scan with a full-range port scan interrupts recording. To prevent recording loss, use
these options:

Instead of a full-range port scan, run a filtered-range port scan with the Service Discovery
function.

A filtered-range port scan excludes ports used by NICE components on each server type. See
the Port List document for ports to be excluded.

Run full Nessus scans only when the system is idle, and no recordings are made.

Interactions Center
A full Nessus scan with a full-range port scan and the Service Discovery function interrupts
recording. To prevent recording loss, use these options:

Run a full-range port scan without Service Discovery.

Run full Nessus scans only when the system is idle, and no recordings are made.
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19:SQL Backup

This section provides guidelines for backing up NICE Engage Platform SQL databases.
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SQL Backup Guidelines
Overview
Customers can implement their own database backup policies for NICE Engage Platform
database.

NOTE:

Each backup schedule provides a different level of recovery. Customers should
match recovery levels according to their needs.

The customer is responsible for database backup operations. They should
ensure that there is enough free space for the database and backups.

Customers MUST NOT restore the SQL database from the backup to production
system without first consulting with NICE Customer Services.

Backup software should be used when the size of any of the NICE server
databases are approximately 1TB and larger. SQL Backup jobs should not be
used in such a scenario.

Schedule
The backup schedule should include full backup, differential backup, and log backup. The backup
plan must include all NICE databases and system databases.

Below is a sample backup schedule:

Full Backup: once a week during off/low peak hours.

Differential Backup: daily backup during off/low peak hours.

Log Backup: for sites that include the Media Encryption solution, the nice_crypto database
is set to Full Recovery Model. Hourly backup is recommended.

Important!

The Full Recovery Model is approved only for DR3.X environments with SQL Server
database mirroring.

Backup Files Location
Database backup files should be stored for long term storage at a remote location, and not on the
server’s hard drive.
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Implementation Guidelines
If the customer’s backup policy does not include the regular NICE Engage Platform backup jobs,
they should be disabled. In this situation, the relevant NICE Sentinel alarms should also be
disabled.

Disable the following SQL Jobs on the Database server:

Nice Differential Backup

Nice Full Backup

Nice Log Backup

Disable the following SQL Jobs on the Data Mart server:

Nice Differential Backup

Nice Full Backup

Nice Log Backup

If the environment consist of multi Data Hub deployment, SQL backup jobs on all Data Hubs must
be disabled.

Backup Tools
Customers can use any off-the-shelf Microsoft SQL Server Backup tools that suits their backup
and restore needs while taking into consideration that the NICE Engage Platform database backup
must be performed during off peak or low peak hours.
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Database Configuration Guidelines
NICE Engage Platform databases can be configured for the Full Recovery Model taking into
consideration the following:

SQL Server log backups are essential.

In the Full Recovery Model, all transactions are logged in the transactional log until they
are backed up. Therefore, log backups must be created on a regular basis. Hourly backup
is recommended.

Transactional log disk space monitoring is essential. If the transactional log is not purged
due to backup failure, new transactions and/or calls will not be added to the database.
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20:Using Real-Time Solutions with App-V

This appendix lists the limitations and rules for working with Real-Time Solutions in an App-V
environment.
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Working with the App-V System
The App-V Sequencer (Microsoft Application Virtualization Sequencer) is a wizard-based tool that
administrators use to transform traditional applications into virtual applications. The Sequencer
produces an application package that contains several files. These files include a sequenced
application (.sft) file, one or more Open Software Description (.osd) application configuration files,
one or more icon (.ico) files, a manifest xml file that can be used to distribute sequenced
applications with electronic software delivery (ESD) systems, and a project (.sprj) file. The
Sequencer can also generate a Windows Installer file (.msi) that can be deployed to clients
configured for standalone operation. All files are stored in a shared content folder on the
Management and/or Streaming Server and are used by the App-V Client to access and run
sequenced applications.

The App-V Management Server (Microsoft Application Virtualization Streaming Server) has
streaming capabilities that including active/package upgrade without Active Directory or SQL
Server requirements. However, it does not have a publishing service, licensing, or metering
capabilities. The publishing service of the App-V Management Server is used in conjunction with
the App-V Streaming Server, so the Management Server configures the application but the
Streaming Server delivers it (usually in branch offices).
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App-V Limitations when Working With Real-
Time Solutions
In App-V environments a bubble is an isolated environment streamed from the App-V server to
the App-V client. On the client machine the application does not have to be installed.

When streaming the Real-Time Client to the App-V client, both clients must be in the same bubble
as the application(s) you want to interact with.

If the Real-Time Client needs to interact with two App-V applications from separate bubbles, you
must install the Real-Time Client on each bubble and interact using C2C (client to client)
communication between the Real-Time Clients. In his case you must instal another Real-Time
Client on the local computer and interact with the streamed clients using C2C.
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21:Using Real-Time Solutions with Citrix
Streaming

This appendix describes the limitations and rules for working with Real-Time Solutions with Citrix
streaming.
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Working with Citrix Streaming
A streamed application in Citrix resides in a separate memory space and environment and is
delivered to the Citrix client without installing an application on the client side. The streamed
application is located in a controlled isolated environment (sandbox).

To set a package for Citrix application streaming so that the Real-Time Client can capture other
streamed applications both applications must run inside the same sandbox. The citrix profiles
must be installed on a separate dedicated machine.
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Citrix Streaming Limitations when Working
With Real-Time Solutions
The Real-Time Client must be part of the same streaming package as the monitored applications.
Another option is to use Inter-Isolation communication for Real-Time Client interaction with other
streamed packages. You can install the Real-Time Client on the client computer to interact with
one or more Citrix streamed applications.

Make sure of the following when setting up the Citrix Profiler:

In the Support Legacy Offline Plug-ins page, select Enable support for 6.0 Offline Plug-ins.

In the Select Install Page, select Advanced Install.

In the Set up Inter-Isolation Communication page make sure to enter the path to the
Profiler Package if you want to link between the profile package for the Real-Time client
and other streamed applications.

In the Select Install Method page, select Run install program or command line script.

In the Choose Installer page, browse to or type in the path to the Process Optiization
Client.msi.

When the Profiler is finished and the Citrix package is ready, make sure of the following:

For a streamed Real-Time Client package, open the Target Properties configuration window
and clear Enable pre-launch analysis.

The remaining Target Properties rules should remain with their default values.

NOTE: The Real-Time Client can interact with two streamed applications (each
from a different server) only when it is installed locally.
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